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URL: https://waxxbrandz.com/

Platform: unknown

Archetype: fun

Run ID: 2026-04-19T06-18-18-831Z

Scanned: 2026-04-19T07:08:29.000Z

Duration: 970s

This is a monthly deep audit. The crawler performed a full-site scan including

Lighthouse performance, axe-core accessibility (WCAG 2.2 AA), cross-browser compatibility,

security headers, schema markup validation, and SEO best-practice checks.

Because this site is not a repository we control, Apex Sentinel **cannot automatically

apply fixes** — instead, each finding below includes an AI-generated plain-English

explanation + step-by-step recommended fix you can hand to a developer or execute

in your CMS directly.

Executive Summary

Overall grade: F

DIMENSION COUNT MEANING

Pages crawled 22 Full sitemap + linked pages

P0 (critical) 1 Site-down or compliance-breaking

P1 (urgent) 6 Significant revenue / SEO / UX impact

P2 (high) 85 Quality / ranking / trust degradation
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DIMENSION COUNT MEANING

P3 (medium) 76 Polish + optimization

"Do first" items 7 AI-flagged top priorities

Quick wins (< 30 min) 25 Fastest ROI items

Top 10 Actions (Ranked)

If you only have time for ten things this month, do these — in this order.

1. [P0] 🔴  DO FIRST Sensitive artifact exposed: /wp-login.php — _Exposed login pages are prime targets

for automated attacks that try thousands of password combinations, risking account takeover, malware

injection, and data theft—any of which could shut down your dispensary site and damage customer trust._

Page: https://waxxbrandz.com/wp-login.php

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST Age gate not detected — _Operating without an age gate exposes Waxx Brandz to

license suspension, civil penalties, and loss of the ability to sell—this is a compliance emergency that

directly threatens your legal right to operate._

Page: https://waxxbrandz.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST Page returns 404: https://waxxbrandz.com/california-vape-guide/ — _This broken

page wastes crawl budget, confuses potential customers, and signals to Google that your site maintenance

is poor—harming rankings for cannabis-related search terms where you need visibility._

Page: https://waxxbrandz.com/california-vape-guide/

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST Page returns 404: https://waxxbrandz.com/diamonds-vs-live-resin-distillate/ —

_You're losing potential customers who searched for product comparisons and landed on a 404 error

instead of a sale; you're also wasting search engine crawl budget on a non-existent page, which hurts your

visibility for pages that do exist._

Page: https://waxxbrandz.com/diamonds-vs-live-resin-distillate/

Effort: Quick win (< 30 min)

1. [P1] 🔴  DO FIRST Page returns 404: https://waxxbrandz.com/fix-disposable-vape-clog/ — _Dead links

hurt your search ranking, waste SEO efforts, and create a poor user experience that can push potential

customers to competitors._

Page: https://waxxbrandz.com/fix-disposable-vape-clog/

Effort: Quick win (< 30 min)
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1. [P1] 🔴  DO FIRST 21 broken internal link(s) — _Broken links frustrate customers, kill SEO crawl efficiency

(search engines waste budget on dead pages instead of indexing fresh content), and reduce internal link

authority flow that helps your best pages rank higher for cannabis keywords._

Page: https://waxxbrandz.com/

Effort: Moderate (1-3 hours)

1. [P1] 🔴  DO FIRST A11y: Frames must have an accessible name — _This accessibility barrier violates

WCAG 2.1 Level A standards and exposes Waxx Brandz to legal liability under the ADA; it also excludes

visually impaired customers from engaging with your product content and brand story._

Page: https://waxxbrandz.com/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH Missing meta description — _Lower click-through rates from search results, because

potential customers can't quickly see what the page offers before deciding to visit._

Page: https://waxxbrandz.com/industry/trends/

Effort: Quick win (< 30 min)

1. [P2] 🟠  HIGH 20 image(s) missing alt text — _You're losing traffic from image search (Google Images),

excluding disabled customers from a key content page, and creating legal risk under accessibility laws (ADA,

AODA) that apply to e-commerce sites in most US states._

Page: https://waxxbrandz.com/industry/trends/

Effort: Moderate (1-3 hours)

1. [P2] 🟠  HIGH Missing meta description — _Users searching for cannabis legalization news may skip your

content in favor of competitors who have clear, compelling descriptions; this directly reduces organic traffic

and potential customer discovery._

Page: https://waxxbrandz.com/industry/legalization-updates/

Effort: Quick win (< 30 min)

Findings by Severity

P0 — 1 finding

1. Sensitive artifact exposed: /wp-login.php

Severity: P0 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: security

Page URL: https://waxxbrandz.com/wp-login.php

Rule: tier5.exposed.artifact

What it means (plain English)
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Your WordPress admin login page is publicly accessible at waxxbrandz.com/wp-login.php. This is a security risk

because it gives attackers a known entry point to attempt break-ins. While WordPress sites naturally have this

file, it should be hidden behind additional security layers so only you can find it.

Why it matters for your business: Exposed login pages are prime targets for automated attacks that try

thousands of password combinations, risking account takeover, malware injection, and data theft—any of which

could shut down your dispensary site and damage customer trust.

Technical root cause: WordPress installs include wp-login.php by default, and without server-level access

controls (firewall rules, IP whitelisting, or redirect rules), it remains discoverable and attackable from the public

internet.

Recommended fix — step by step

1. Log into your hosting control panel (cPanel, Plesk, or your host's dashboard) and locate the Web Application

Firewall (WAF) or ModSecurity rules section.

2. Create a new rule to block or redirect all requests to /wp-login.php, /wp-admin/, and /xmlrpc.php unless the

request comes from your office IP address.

3. Alternatively, install the Wordfence Security plugin (free version): Plugins → Add New → search 'Wordfence'

→ install and activate → go to Wordfence → All Options → Brute Force → enable 'Protect wp-login.php' and

set a rate limit to 3 login attempts per 5 minutes.

4. If using Wordfence, also enable 'Rename login URL' (Wordfence → All Options → Login Security) to move

login to a custom path like /waxx-admin-login.

5. Test by visiting waxxbrandz.com/wp-login.php in an incognito browser—it should show a 403 Forbidden

error or redirect, not a login form.

6. Confirm the change is live by waiting 10 minutes and testing again to account for caching.

P1 — 6 findings

1. Age gate not detected

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: compliance

Page URL: https://waxxbrandz.com/

Rule: tier1.compliance.age-gate-missing

What it means (plain English)

Your homepage doesn't display an age verification prompt before visitors can access cannabis product content.

Cannabis retailers are legally required to verify customers are 21+ before allowing access to the sales area.

Without this gate, you risk regulatory violations and potential fines from state cannabis control boards.

Why it matters for your business: Operating without an age gate exposes Waxx Brandz to license suspension,

civil penalties, and loss of the ability to sell—this is a compliance emergency that directly threatens your legal

right to operate.

Technical root cause: The age-gate mechanism is either missing entirely from the site code, or it exists but

only triggers on a subpage (not the homepage), or it's JavaScript-based and didn't render during the initial

page load scan.
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Recommended fix — step by step

1. Audit your current setup: visit https://waxxbrandz.com/ in an incognito/private browser and confirm whether

an age prompt appears before any product images, menus, or 'Shop Now' links are visible.

2. If no prompt appears, implement a full-page age gate using one of three approaches: (1) a modal dialog that

blocks interaction until 'Yes, I'm 21+' is clicked, (2) a dedicated /age-verify landing page that redirects to the

homepage only after verification, or (3) a persistent cookie that remembers verification for 30 days per state

law.

3. If using WordPress with WooCommerce, install the 'Age Gate Pro' or 'Ultimate Age Gate' plugin, configure it

to display on page load (not on scroll), and set the cookie expiry to 30 days.

4. If custom-built or platform-unknown, add a <div id='age-gate'>  overlay to the top of your HTML

body with a clear 'Are you 21 or older?' message and two buttons: 'Yes' and 'No.' The 'No' button should

redirect to a compliant exit page (e.g., https://www.google.com); the 'Yes' button should set a

sessionStorage or localStorage flag and a secure, HttpOnly cookie.

5. Test the age gate in all major browsers (Chrome, Firefox, Safari, Edge) and on mobile devices—verify it

appears before product listings, pricing, or order forms load.

6. Add a <meta name='age-gate-verified'>  tag or visible badge near your license information

stating 'Age Verification: Required at Entry' to signal compliance to regulators and auditors.

7. Document your age-gate policy (e.g., '30-day cookie retention, no exceptions') and store it in your legal

compliance folder—you may need to show this to state regulators.

2. Page returns 404: https://waxxbrandz.com/california-vape-guide/

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/california-vape-guide/

Rule: tier2.page.404

What it means (plain English)

A page listed in your sitemap (the file search engines use to find content) is returning a 404 error, meaning it no

longer exists or is broken. Search engines and customers who click links to this page will hit a dead end,

damaging both SEO rankings and user experience.

Why it matters for your business: This broken page wastes crawl budget, confuses potential customers, and

signals to Google that your site maintenance is poor—harming rankings for cannabis-related search terms

where you need visibility.

Technical root cause: The page was either deleted, moved, or the URL path changed without a redirect in

place. The sitemap still references the old URL, creating a mismatch.

Recommended fix — step by step

1. Check if the page still exists by visiting https://waxxbrandz.com/california-vape-guide/ directly; if it does not

load, confirm the page was intentionally removed

2. Search your site's WordPress admin (or CMS) for 'california-vape-guide' to see if the page exists in draft,

trash, or under a different URL

3. If the page was moved: use a 301 permanent redirect plugin (Redirection, Yoast SEO Premium, or Rank

Math) to point the old URL to the new location

4. If the page was deleted intentionally: remove it from the sitemap by editing the sitemap XML file (usually

/sitemap.xml or via SEO plugin settings) or regenerating the sitemap
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5. After fixing, test the URL again and resubmit the sitemap to Google Search Console (Search appearance >

Sitemaps > click your sitemap > Request indexing)

6. Check Google Search Console for other 404s in the Coverage report and repeat this process for any others

3. Page returns 404: https://waxxbrandz.com/diamonds-vs-live-resin-

distillate/

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/diamonds-vs-live-resin-distillate/

Rule: tier2.page.404

What it means (plain English)

Your sitemap lists a product comparison page (diamonds vs. live resin distillate) that no longer exists on your

site. When customers click links to this page from search results or your sitemap, they hit a dead end. Search

engines also see this as a broken promise, which damages your credibility in their rankings.

Why it matters for your business: You're losing potential customers who searched for product comparisons

and landed on a 404 error instead of a sale; you're also wasting search engine crawl budget on a non-existent

page, which hurts your visibility for pages that do exist.

Technical root cause: The page was either deleted, moved, or unpublished without updating the sitemap or

setting up a redirect from the old URL to a similar working page.

Recommended fix — step by step

1. Check your site's content management system (WordPress admin → Pages, or equivalent) to confirm

whether this page exists in draft form or was permanently deleted.

2. If the page was deleted intentionally, remove the URL from your sitemap: find sitemap.xml in your site root,

open it, delete the <url><loc>https://waxxbrandz.com/diamonds-vs-live-resin-distillate/</loc></url> entry,

save, and upload.

3. If the page still exists but is hidden, publish it or restore it from trash.

4. If the content has been moved or renamed, identify the new URL and set up a 301 redirect from the old URL

to the new one (in WordPress: use Redirection plugin → New Redirect → Old URL → New URL; or ask your

hosting provider for server-level redirect rules).

5. After fixing, submit your updated sitemap to Google Search Console (Search Console → Sitemaps → paste

your sitemap URL → Request indexing) and Bing Webmaster Tools.

4. Page returns 404: https://waxxbrandz.com/fix-disposable-vape-clog/

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/fix-disposable-vape-clog/

Rule: tier2.page.404

What it means (plain English)
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One of your pages listed in your sitemap (the file search engines use to discover content) is returning a 404

error — meaning it no longer exists or is misconfigured. When customers click links to this page or Google tries

to index it, they hit a dead end. This wastes crawl budget and frustrates both users and search engines.

Why it matters for your business: Dead links hurt your search ranking, waste SEO efforts, and create a poor

user experience that can push potential customers to competitors.

Technical root cause: The page either was deleted without a redirect, the URL slug is misspelled in the

sitemap, or the page exists but is blocked from public access (e.g., draft status, access restrictions).

Recommended fix — step by step

1. Visit https://waxxbrandz.com/fix-disposable-vape-clog/ directly to confirm the 404.

2. Check your sitemap file (usually at /sitemap.xml) and verify the URL matches the actual published page slug.

3. If the page content still exists, publish it or change its status from draft to live (check your CMS admin under

Pages/Posts).

4. If the page was intentionally deleted, remove it from the sitemap and set up a 301 redirect from the old URL

to a relevant replacement page (e.g., a general troubleshooting guide).

5. Regenerate and resubmit your sitemap to Google Search Console (Indexing > Sitemaps > Submit).

6. Monitor Google Search Console for crawl errors to catch similar issues early.

5. 21 broken internal link(s)

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/

Rule: tier2.links.broken

What it means (plain English)

Your website has 21 broken internal links — URLs that point to pages that no longer exist or are misconfigured.

When visitors click these links, they hit dead-end 404 error pages, which damages trust and prevents search

engines from properly crawling and ranking your content. This is especially harmful for a content-driven site like

yours, where these links often appear in navigation, breadcrumbs, and article cross-references.

Why it matters for your business: Broken links frustrate customers, kill SEO crawl efficiency (search engines

waste budget on dead pages instead of indexing fresh content), and reduce internal link authority flow that

helps your best pages rank higher for cannabis keywords.

Technical root cause: The pattern shows two main issues: (1) pages exist without the trailing index.php file,

but internal links still reference index.php (e.g., /trends/  exists, but links point to

/trends/index.php ), and (2) some links point to URLs that were deleted or moved without redirects set

up. This suggests either a CMS misconfiguration or a recent site restructure without proper 301 redirect

mappings.

Recommended fix — step by step

1. Run a full audit using Screaming Frog SEO Spider (free version) — crawl your entire site, export the 'Broken

Links' tab, and confirm all 21 URLs and their sources

2. Check your CMS/server configuration: if using WordPress, install Redirection plugin → Tools → Redirection →

'Import' section, then manually create 301 redirects from each broken link to the correct live page; if using a

static server or custom CMS, request your hosting provider add these rules to .htaccess or web server

config
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3. Audit your template/theme files: search your codebase (or WordPress editor) for hardcoded links containing

'index.php' — remove or update them to clean URLs (e.g., change /trends/index.php  to

/trends/ )

4. For the Instagram redirect link ( /redirect/?type=ig... ), verify that your redirect service is working
— test it manually in a browser; if it returns 404, either restore the redirect handler script or remove the link

and link directly to your Instagram profile

5. Create and implement 301 redirects for all 21 broken URLs: map each old URL to the correct new page using

your CMS redirect plugin or server config

6. Use Google Search Console → Coverage → Excluded → 'Not Found (404)' to verify the broken links are

resolved after redirects are live (may take 1–2 weeks to re-crawl)

7. Set up a monthly broken link monitoring: use a free tool like Dr. Link Check or the Redirection plugin's built-

in monitor to catch future breaks early

6. A11y: Frames must have an accessible name

Severity: P1 | Priority: 🔴  DO FIRST

Effort: Quick win (< 30 min)

Business category: compliance

Page URL: https://waxxbrandz.com/

Rule: tier9.a11y.frame-title

What it means (plain English)

Your website has an embedded video player (iframe element) that screen readers cannot identify or describe to

visually impaired visitors. Screen readers are software that reads web content aloud to blind and low-vision

users. Without a label, they announce it as just "iframe" with no context, making it impossible for these users to

understand what content is embedded.

Why it matters for your business: This accessibility barrier violates WCAG 2.1 Level A standards and exposes

Waxx Brandz to legal liability under the ADA; it also excludes visually impaired customers from engaging with

your product content and brand story.

Technical root cause: The iframe element lacks a title attribute, aria-label, or aria-labelledby attribute that

would provide an accessible name for assistive technologies to announce.

Recommended fix — step by step

1. Inspect the iframe in your page source (right-click → View Page Source, search for '<iframe') and identify

what content it displays (e.g., 'Product demo video', 'Customer testimonial', 'Brand story')

2. Add a title attribute to the iframe with a concise, descriptive label: <iframe title="Waxx Brandz product

overview video" src="...">

3. Alternatively, if the iframe is near a visible heading, add aria-labelledby="heading-id" where heading-id

matches the id of that heading

4. Test the fix using a free accessibility checker (WAVE browser extension) or by tabbing through the page with

a keyboard to confirm the iframe is now announced

5. If this iframe is embedded by a third-party service (e.g., video hosting, customer reviews widget), contact

that vendor to request they provide configurable title/label options for their embed code

P2 — 85 findings
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1. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/industry/trends/

Rule: tier2.meta.no-description

What it means (plain English)

Your /industry/trends/ page is missing a meta description — the 160-character summary that appears below

your page title in Google search results. Without it, Google generates a random snippet from your page content,

which often looks unprofessional and fails to tell customers why they should click your link.

Why it matters for your business: Lower click-through rates from search results, because potential customers

can't quickly see what the page offers before deciding to visit.

Technical root cause: The <meta name="description" content="..."> tag is absent from the page's HTML

<head> section.

Recommended fix — step by step

1. Access your /industry/trends/ page in your CMS or HTML editor

2. Locate the <head> section of the page's HTML

3. Add this tag: <meta name="description" content="Explore the latest cannabis industry trends, market

insights, and emerging products from Waxx Brandz.">

4. Keep the description between 150–160 characters (Google truncates longer ones)

5. Include your primary keyword ('cannabis trends' or similar) naturally in the description

6. Repeat this fix for all other pages lacking meta descriptions (run your audit tool across the full site to

identify them all)

7. If using a CMS (WordPress, Shopify, etc.), use the SEO plugin (e.g., Yoast SEO → Edit snippet) instead of

manual HTML editing

2. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/industry/trends/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Trends page lacks alt text — the hidden text description that screen readers (used by blind

and low-vision visitors) read aloud, and that search engines use to understand what an image contains. All 20

images on that page are missing this. This blocks both disabled users from understanding your content and

search engines from indexing those images in image search results.

Why it matters for your business: You're losing traffic from image search (Google Images), excluding disabled

customers from a key content page, and creating legal risk under accessibility laws (ADA, AODA) that apply to

e-commerce sites in most US states.
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Technical root cause: Images were added to the page without descriptive alt attributes in the HTML. This is

typically a content management oversight — either the CMS doesn't enforce alt text on upload, or editors

skipped the field.

Recommended fix — step by step

1. Open https://waxxbrandz.com/industry/trends/ in your browser and note which images appear (product

shots, charts, lifestyle photos, etc.).

2. Open your site's admin panel / content editor for that page and locate the image block or media insertion

tool.

3. For each image, click or double-click it to open its properties/edit modal, find the 'Alt Text' or 'Alternative

Text' field, and write a 5–15 word description (e.g., 'Waxx Brandz cannabis flower in glass jar with label' or

'Cannabis industry growth chart 2024').

4. Prioritize product and chart images first — these are most valuable to search and users.

5. After editing, save/publish the page, then open it in a fresh browser tab and refresh to confirm changes are

live.

6. If your CMS doesn't show an alt text field, contact your hosting provider or developer to confirm alt

attributes are being rendered in the HTML; they may need to add the field to your template.

3. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/industry/legalization-updates/

Rule: tier2.meta.no-description

What it means (plain English)

The page about legalization updates is missing a meta description—the 150-160 character summary that

appears under your page title in Google search results. Without it, Google generates a random snippet from

your page content, which often looks unprofessional and doesn't persuade people to click.

Why it matters for your business: Users searching for cannabis legalization news may skip your content in

favor of competitors who have clear, compelling descriptions; this directly reduces organic traffic and potential

customer discovery.

Technical root cause: The HTML <head> section is missing a <meta name="description" content="..."> tag for

this specific page. WordPress sites typically auto-generate these from Yoast SEO or similar plugins; this page

either has the plugin disabled or the field was left blank.

Recommended fix — step by step

1. Log into your WordPress admin (or inspect the page source at waxxbrandz.com/industry/legalization-

updates/ to confirm whether WordPress is in use).

2. If WordPress: Install or activate Yoast SEO (if not already active), navigate to the 'Legalization Updates'

post, scroll to the Yoast panel, and fill in the 'Meta description' field with 150–160 characters summarizing

the post (e.g., 'Latest cannabis legalization news and regulatory updates for 2024. Stay informed on

compliance changes affecting your dispensary.').

3. If not WordPress (static HTML): Open the page source file, locate the <head> section, and add <meta

name="description" content="[your 150-160 character summary]">.

4. Repeat this check for all other major content pages (product pages, blog posts, FAQs) to ensure consistent

SEO metadata across the site.
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5. Publish/deploy the changes and monitor Google Search Console (google.com/search-console) within 1–2

weeks to confirm the new description appears in search results.

4. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/industry/legalization-updates/

Rule: tier2.schema.none

What it means (plain English)

Your website isn't using JSON-LD structured data—a machine-readable format that tells Google what your

pages are about. This is like having a product on a shelf with no label; search engines have to guess. For a

cannabis retailer, this means Google can't clearly understand your product listings, dispensary location, or

compliance information, reducing your chances of appearing in rich search results (like product carousels or

local pack listings).

Why it matters for your business: Without schema markup, your product pages won't qualify for Google's rich

snippets, and you'll lose visibility against competitors who do use it—especially critical since cannabis SEO is

already highly competitive and geographically constrained.

Technical root cause: The page HTML contains no <script type="application/ld+json"> blocks. Schema markup

must be explicitly added to the page template or injected via a plugin/tool.

Recommended fix — step by step

1. Audit your site architecture: identify all template types (product pages, blog posts like the legalization-

updates page, dispensary info, etc.).

2. For blog/article pages like /industry/legalization-updates/, add Article schema at minimum: go to

schema.org, copy the Article template, fill in headline, datePublished, author, and image, then paste as a

<script type="application/ld+json"> block in your page <head>.

3. For product/dispensary pages, add Product schema (SKU, price, availability) and/or LocalBusiness schema

(address, phone, hours, license info—critical for cannabis compliance).

4. If using WordPress: install Yoast SEO or RankMath plugin → Settings → XML Sitemaps → enable schema

features, then review each page's schema preview in the plugin editor.

5. If using a static HTML site or custom CMS: manually insert schema blocks or use a headless schema tool

like Microdata or JSON-LD generator; test with Google's Rich Results Test

(https://search.google.com/test/rich-results) for each template type.

6. Prioritize Product schema for any cannabis SKUs (flower, edibles, concentrates) and LocalBusiness schema

for your dispensary info—these directly impact local SEO and compliance transparency.

7. Re-crawl the affected URL and other key pages with Google Search Console after adding schema; monitor

the 'Enhancements' report for schema errors.

5. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/industry/legalization-updates/
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Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Legalization Updates page is missing alt text — a short text description that describes what

the image shows. Screen readers (used by visually impaired visitors) can't tell users what these images contain,

and search engines can't index them either. This is a compliance gap under WCAG 2.1 accessibility standards.

Why it matters for your business: You're losing SEO value on image search, excluding customers with

disabilities (legal liability under ADA/AODA), and damaging user trust with visitors who rely on assistive

technology.

Technical root cause: Images were uploaded without alt attributes populated in the HTML. This is a common

CMS oversight where alt fields are left blank during image insertion.

Recommended fix — step by step

1. Export a list of all 20 images from the Legalization Updates page (screenshot URLs or use your CMS media

library view).

2. For each image, write a 5–10 word alt text describing what it shows (e.g., 'Cannabis legalization timeline

infographic for 2024').

3. If you use WordPress: go to Media Library → click each image → fill in the Alt Text field → Save. If Shopify:

Products → select product → edit image → fill Alt text field.

4. If platform is unknown, inspect the page source (right-click → View Page Source) to identify the CMS, then

follow its documentation for bulk alt text updates.

5. After updating all 20 images, re-run an accessibility scan (use WAVE.webaim.org or Lighthouse in Chrome

DevTools) to confirm alt text is present.

6. Document alt text for future uploads to prevent regression.

6. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/industry/market-growth/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Market Growth page is missing alt text — a short text description that screen readers use

to describe images to visually impaired visitors, and that search engines use to understand what your images

show. This means anyone using a screen reader gets no context for those images, and Google can't properly

index them.

Why it matters for your business: Missing alt text reduces your search visibility for image-based queries

(product photos, strain images, etc.) and excludes visually impaired customers from your content, shrinking

your addressable audience.

Technical root cause: Images were uploaded without alt text filled in during content creation, or the CMS

template does not enforce alt text as a required field.

Recommended fix — step by step

1. Open https://waxxbrandz.com/industry/market-growth/ in your browser and open the page inspector (right-

click → Inspect).
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2. Search the HTML for <img> tags; note which ones lack the alt="..." attribute.

3. If using WordPress: go to Media → Library, find each image, click it, and fill the Alt Text field with a 5–10

word description (e.g., 'Cannabis market growth chart 2020–2024').

4. If using a page builder (Elementor, Divi, Gutenberg blocks): edit the page, click each image block, and fill the

Alt Text field in the sidebar.

5. For images that are purely decorative, set alt="" (empty) to tell screen readers to skip them.

6. Test using a free tool like WAVE (https://wave.webaim.org/) and paste your URL to verify all images now have

alt text.

7. Repeat for any other product/content pages that show alt-text warnings in WAVE.

7. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/industry/innovation/

Rule: tier2.meta.no-description

What it means (plain English)

Your product page at /industry/innovation/ is missing a meta description — the 155-character summary that

appears below your page title in Google search results. Without it, Google may auto-generate a snippet from

your page content, which often looks choppy or incomplete to potential customers.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results;

customers see a truncated or irrelevant preview and click competitors instead, directly reducing organic traffic

and sales.

Technical root cause: The HTML <head> section on this page lacks a <meta name="description"

content="..."> tag. Either the page was published without one, or the template/plugin that generates meta tags

skipped this page.

Recommended fix — step by step

1. Open https://waxxbrandz.com/industry/innovation/ in your browser, right-click → Inspect → find the <head>

section and confirm <meta name="description"> is absent

2. Write a 150–160 character meta description for this page that includes your primary keyword (e.g., 'Explore

Waxx Brandz innovation in premium cannabis products — lab-tested quality, cutting-edge strains, and

exclusive drops.')

3. If using WordPress: install Yoast SEO or Rank Math, go to the page editor, scroll to the plugin panel, paste

the description into the 'Meta Description' field, and save

4. If using Shopify: edit the page, click 'Search engine listing preview' in the lower right, paste the description

into the meta description box, and save

5. If platform is custom/unknown: add <meta name="description" content="YOUR TEXT HERE"> to the <head>

of /industry/innovation/ HTML template or contact your hosting provider to add it via server config

6. Audit all other pages in /industry/* and product pages for missing meta descriptions using a free tool like

Screaming Frog SEO Spider (crawl mode) or Semrush Site Audit

7. Set a recurring monthly check: use Google Search Console → Pages → filter by 'Missing meta description' to

catch new pages

8. No JSON-LD schema
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Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/industry/innovation/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include JSON-LD structured data — a machine-readable format that tells search

engines (and voice assistants) what your pages are about. Without it, Google has to guess whether you're

selling cannabis products, offering information, or something else entirely. This is especially important for

cannabis retail, where clarity helps search engines confidently surface your products to customers searching

for legal dispensary options.

Why it matters for your business: Missing schema reduces the likelihood that Google will display your

products in rich snippets (star ratings, prices, availability) in search results, which directly lowers click-through

rates and online discovery for your dispensary.

Technical root cause: The page does not include any JSON-LD schema blocks in the HTML head or body.

Without a template or plugin adding this automatically, pages default to plain HTML with no machine-readable

product, organization, or local business metadata.

Recommended fix — step by step

1. Audit your site architecture: identify key page types (product listings, individual SKUs, homepage,

about/license page) that need schema coverage.

2. If using a CMS (WordPress, Shopify, etc.), install a schema plugin: WordPress users install 'Yoast SEO' or

'Schema Pro', activate it, and configure Product + Organization schema in Settings → Yoast SEO →

Integrations.

3. If hand-coded HTML, add JSON-LD blocks to the <head>: Start with Organization schema (name, license

number if displayable, address, phone) on homepage, and Product schema (name, price, availability,

description) on each product page.

4. For cannabis compliance, ensure schema includes your license/regulatory information where legal and

displayable; consult your legal/compliance team on what to expose.

5. Test each updated page using Google's Rich Results Test (search.google.com/test/rich-results) to confirm

schema is valid and recognized.

6. Submit updated sitemaps and re-crawl through Google Search Console to index the enhanced pages.

9. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/industry/innovation/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Innovation page is missing alt text — descriptive text that screen readers use to tell visually

impaired visitors what an image shows, and that search engines use to understand your content. With 20

missing descriptions, you're leaving SEO value on the table and making your site harder for customers using

assistive technology to navigate.
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Why it matters for your business: Missing alt text reduces your search ranking potential for product discovery,

and excludes customers with visual impairments — a legal exposure under ADA compliance, plus lost sales from

an audience that uses screen readers.

Technical root cause: Images were uploaded without alt text metadata, either because the CMS didn't enforce

it during upload or because the images were added via HTML without the alt attribute populated.

Recommended fix — step by step

1. Log into your site's content management system and navigate to the Innovation page (/industry/innovation/).

2. Find the image upload or media library section; identify all 20 images on that page.

3. For each image, open its properties/settings and add a concise, descriptive alt text (e.g., 'Cannabis

concentrate in glass jar' or 'Waxx Brandz extraction equipment'). Keep each under 125 characters.

4. Prioritize product images and lifestyle shots; these drive SEO and user understanding most.

5. If you use WordPress, install the free plugin 'Yoast SEO' and use its Alt Text Check under SEO → Readability

to flag and fix missing alt text across your entire site.

6. Test by opening the page in a screen reader (NVDA for Windows, VoiceOver for Mac) or using an aXe

DevTools browser extension to confirm alt text reads correctly.

7. Repeat this process on any other high-traffic pages (product listing, homepage, about page).

10. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Live Resin vs Live Diamonds page is missing alt text — a short text description that screen

readers use to explain images to blind and low-vision visitors, and that search engines use to understand image

content. This means your images are invisible to both assistive technology users and Google's indexing bots.

Why it matters for your business: You're losing SEO ranking signals (Google can't index image content),

excluding disabled customers from your site, and missing opportunities to rank for image search traffic — all

while creating compliance risk under ADA standards.

Technical root cause: The images in this guide were uploaded or embedded without alt attributes. This is a

common CMS or HTML oversight when images are added without explicit alt text entry.

Recommended fix — step by step

1. Open the Live Resin vs Live Diamonds guide in your site editor and locate the image upload/media library

section.

2. For each of the 20 images, add a brief alt text (2–10 words) describing what the image shows — e.g., 'Live

resin cannabis concentrate in glass jar' or 'Live diamonds crystalline formations close-up'.

3. Prioritize images that show products, cannabinoid profiles, or compliance labels first; decorative images can

use null alt text (alt='') if they add no informational value.

4. If using WordPress, install Yoast SEO or Alt Text by Conduit, then bulk-edit or flag missing alt text in the

Media Library → each image → Alt Text field.

5. If using a custom CMS or static HTML, add alt='' attributes to every <img> tag with descriptive text

matching the image content.
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6. Test the page with WAVE Browser Extension (wave.webaim.org/extension) to confirm all images now show alt

text.

7. Repeat this audit on other high-traffic product and guide pages to catch similar gaps site-wide.

11. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/

Rule: tier2.meta.no-description

What it means (plain English)

This page is missing a meta description — the 155-character summary that appears below your page title in

Google search results. Without it, Google generates a random snippet from your content, which often looks

incomplete or irrelevant to searchers. This reduces click-through rates from search results.

Why it matters for your business: Potential customers searching for vape authenticity guides won't see a

compelling preview of your content, leading to fewer clicks and lower organic traffic to this informational page.

Technical root cause: The HTML <head> section is either missing a <meta name="description" content="...">

tag entirely, or it contains an empty one.

Recommended fix — step by step

1. Open the page source (Ctrl+U or Cmd+U in browser) and search for '<meta name="description"'

2. If missing: add this line in the <head> section: <meta name="description" content="Learn how to spot fake

disposable vapes in California. Our guide covers security features, packaging, and QR code verification to

ensure authentic products.">

3. Keep the description between 150–160 characters (including spaces) and include your target keyword

('authentic disposable vapes')

4. If using WordPress: install Yoast SEO plugin → Pages → edit this guide → scroll to 'Snippet preview' → fill in

the Description field with the text above

5. If using a static site or custom CMS: ask your developer to add the meta tag and test using Google Search

Console Preview Tool

12. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/

Rule: tier2.schema.none

What it means (plain English)

Your site is missing JSON-LD structured data — machine-readable code blocks that tell Google what your

content is about. Without them, search engines can't easily understand whether a page is a blog post, product

listing, or FAQ, which hurts how your content appears in search results and may prevent rich snippets (like star

ratings or featured snippets) from showing.
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Why it matters for your business: Missing schema costs you search visibility and click-through rates;

competitors with proper schema will rank higher and get more featured snippet placements, directly reducing

organic traffic to your guides and product pages.

Technical root cause: The page HTML does not include <script type="application/ld+json"> blocks that

provide semantic markup. This is a code-level omission, not a platform limitation.

Recommended fix — step by step

1. Identify the page template used for /guides/* URLs and add a BlogPosting schema block to the <head>

section with headline, datePublished, dateModified, and author fields.

2. For any product or dispensary location pages, add LocalBusiness or Product schema markup with name,

image, description, and address fields.

3. Use Google's Structured Data Testing Tool (https://search.google.com/test/rich-results) to validate each

schema block before publishing.

4. If using WordPress, install Yoast SEO (free) or Rank Math, open Settings → Titles & Metas → Schema, and

enable schema generation for posts and pages.

5. If on a static or custom platform, manually insert schema JSON-LD blocks into your page templates and test

with Google Rich Results Tester.

6. Add schema for FAQ pages if applicable: use FAQPage schema with mainEntity containing Question and

Answer pairs.

7. Monitor Search Console (Google Search Console → Legacy Tools → Structured Data) monthly to ensure no

schema errors or warnings appear.

13. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/disposable-vapes/california/

Rule: tier2.meta.no-description

What it means (plain English)

Your product page (disposable vapes in California) is missing a meta description—the 160-character summary

that appears under your site name in Google search results. Without it, Google generates its own snippet, which

often looks unprofessional and may not highlight your key selling points like product variety or California

compliance.

Why it matters for your business: A missing meta description reduces click-through rate from search results;

potential customers see a generic or irrelevant preview instead of a compelling reason to visit your site, directly

impacting traffic and sales.

Technical root cause: The HTML <head> element on this page lacks a <meta name="description"

content="..."> tag. This is typically missing during initial page creation or if a template wasn't properly

configured.

Recommended fix — step by step

1. Open the HTML source of https://waxxbrandz.com/disposable-vapes/california/ in your editor or hosting

control panel

2. Locate the <head> section (first 20–40 lines of the page)
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https://waxxbrandz.com/disposable-vapes/california/
https://waxxbrandz.com/disposable-vapes/california/


3. Add this line: <meta name="description" content="Premium disposable vapes in California from Waxx

Brandz. Licensed, tested products with fast delivery. Browse flavors & effects now."> (customize the text to

your key selling points)

4. Save and publish the page

5. Use Google Search Console (search.google.com/search-console) → URL Inspection tool → paste the URL →

click 'Request indexing' to refresh the cached version

6. Check your live search results in Google within 24–48 hours to confirm the new description appears

14. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/disposable-vapes/california/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include structured data—machine-readable code that tells search engines what your

products are, their price, availability, and reviews. Without it, Google has to guess what you're selling, which

means it can't show rich results (star ratings, price badges, availability) in search listings.

Why it matters for your business: Missing schema costs you click-through rate and conversion rate;

customers see a plain text link instead of a rich result showing price, stock status, and reviews, making

competitors' listings more attractive.

Technical root cause: The page HTML lacks JSON-LD blocks in the <head> or <body> that define

LocalBusiness, Product, AggregateRating, or Offer schema types for cannabis products.

Recommended fix — step by step

1. Audit your site structure: identify all product pages (disposables, flower, concentrates, etc.) and their data

fields (name, price, availability, SKU, brand).

2. Add JSON-LD Product schema to each product page's <head> section; at minimum include @context,

@type (Product), name, url, image, description, brand, and offers (with price, priceCurrency, availability).

3. For dispensary locations, add LocalBusiness schema with name, address, telephone, hours, and

aggregateRating if you have reviews.

4. Use Google's Rich Results Test (https://search.google.com/test/rich-results) to validate each schema block

—paste your page URL and confirm no errors appear.

5. Monitor coverage in Google Search Console (Coverage report) to ensure pages are indexed and eligible for

rich results within 2–4 weeks.

15. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/disposable-vapes/california/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)
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Every image on your Disposable Vapes page is missing alt text — a short text description that screen readers

use to describe images to blind and low-vision visitors, and that search engines use to understand your content.

This means visitors using screen readers get no context for your product images, and Google can't index what

those images show.

Why it matters for your business: Missing alt text reduces your search ranking for product pages, blocks

accessibility to customers with vision disabilities (a legal exposure), and weakens your ability to rank for image

search, which drives discovery for product categories like vapes.

Technical root cause: Images were added to the page without descriptive alt attributes in the HTML. This is

typically caused by uploading images without filling in the alt field during upload, or using a page builder that

doesn't enforce alt text on media.

Recommended fix — step by step

1. Open https://waxxbrandz.com/disposable-vapes/california/ in your browser and use Inspect Element (right-

click → Inspect) to view the HTML of one product image.

2. Confirm the <img> tag has no alt attribute or an empty alt="".

3. If you use WordPress: go to Media Library → edit each image → fill the 'Alt Text' field with a concise product

description (e.g., 'Blue Dream disposable vape 1g' instead of 'IMG-2024-01').

4. If you use a page builder (Elementor, Divi, etc.): open the page editor, select each image, and add alt text in

the Image settings panel.

5. If you manage HTML directly: add alt="[product name and key attributes]" to each <img> tag.

6. After updating all 20 images, clear your browser cache (Ctrl+Shift+Delete) and revisit the page to confirm alt

text renders in Inspect Element.

7. Submit the updated page URL to Google Search Console (go to Indexing → URL Inspection, paste the URL,

click 'Request Indexing').

16. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/

Rule: tier2.schema.none

What it means (plain English)

Your homepage doesn't include JSON-LD structured data—a machine-readable format that tells search engines

(Google, Bing) what your business is, where it's located, and what products you sell. Without it, search engines

have to guess the meaning of your content, which can hurt your visibility in local search results and product

listings.

Why it matters for your business: Cannabis retailers rely heavily on local search to drive foot traffic; missing

schema means you're invisible to 'dispensaries near me' queries and Google Business Profile integrations that

could drive qualified customers to your storefront.

Technical root cause: The homepage HTML contains no <script type="application/ld+json"> blocks. This is

typically missing because the site was built without structured data implementation from the start, or a CMS

lacks a schema plugin.

Recommended fix — step by step
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1. Audit your site's CMS / platform: check if WordPress (inspect Plugins > installed; look for Yoast SEO,

RankMath, SchemaApp), Shopify (check Apps > SEO), or custom HTML. If unknown, request source-code

review from your web host or developer.

2. If WordPress: install Yoast SEO (free) → go to Admin > SEO > General → Business entity section → fill in

business name, address, phone, hours, image. Yoast auto-generates LocalBusiness schema.

3. If Shopify: install SEO Manager (free) → Products → enable 'Product structured data' toggle for all product

pages.

4. If custom HTML: manually add LocalBusiness schema to homepage and Product schema to product pages.

Use Google's Structured Data Helper (https://www.google.com/webmasters/markup-helper/) to generate

JSON-LD blocks; paste into page <head> or footer.

5. Add key fields: business name, street address, city/state/zip, phone, hours of operation, service area (if

delivery/curbside), license number or compliance badge (if applicable in your state).

6. Test using Google's Rich Results Test (https://search.google.com/test/rich-results) to confirm schema is

valid and eligible for rich snippets.

7. Submit updated pages to Google Search Console → URL Inspection → Request Indexing to refresh schema

recognition.

17. 26 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your site has 26 images without alt text—short descriptions that explain what each image shows. Search

engines can't read images, so they rely on these descriptions to understand your content. People using screen

readers (assistive technology for vision-impaired visitors) also can't see images without alt text. This creates

both an SEO disadvantage and an accessibility barrier.

Why it matters for your business: Missing alt text reduces your search ranking for image-related queries,

limits your reach to customers with visual impairments, and may expose you to accessibility compliance risk if

your state has specific requirements for public-facing cannabis retail sites.

Technical root cause: Images were likely uploaded without alt text attributes being filled in during content

creation. This is common when using page builders or content management systems if the alt field is left blank

by default.

Recommended fix — step by step

1. Identify your platform: view page source (Ctrl+U or Cmd+U) and look for 'wp-content' (WordPress), 'wix'

(Wix), 'shopify' (Shopify), or similar identifiers; document the platform name.

2. If WordPress: log into wp-admin → Media Library → filter by 'Unattached' or sort by date; select each image

and fill in the 'Alt Text' field with a short, descriptive phrase (e.g., 'Waxx Brandz premium cannabis flower

package').

3. If Wix: go to your Editor → each image element → SEO panel → fill in the Alt Text field.

4. If Shopify: Products → each product image → click image → Alt Text field → add description.

5. If custom HTML/unknown platform: ask your developer to add alt="[description]" to each <img> tag in the

source code.
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6. Prioritize product images, hero images, and any image that communicates product type, strain, or branding.

7. Test: use a free tool like WAVE (wave.webaim.org) or axe DevTools browser extension to re-scan the

homepage and verify all images now show alt text.

8. Create a content checklist for future uploads: 'Always fill alt text before publishing images.'

18. Missing canonical

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/blog-page/

Rule: tier2.meta.no-canonical

What it means (plain English)

Your blog page doesn't have a canonical tag — a line of code that tells search engines which version of a page

is the 'official' one. Without it, search engines may get confused if the same content appears under multiple

URLs (like with or without www, or with tracking parameters), which dilutes your SEO ranking.

Why it matters for your business: Missing canonicals reduce the likelihood your blog content ranks well in

Google search results, limiting organic traffic to your site and reducing discoverability for customers searching

for cannabis product information.

Technical root cause: The page is missing a <link rel="canonical" href="https://waxxbrandz.com/blog-page/"

/> tag in the HTML head section. This is either due to the CMS not auto-generating it or a manual omission

during page creation.

Recommended fix — step by step

1. Log into your CMS admin panel and navigate to the blog page editor for https://waxxbrandz.com/blog-page/

2. Look for an SEO settings section (often labeled 'SEO', 'Meta', or 'Search Engine Optimization') — if using

WordPress, install Yoast SEO plugin and check the 'Canonical URL' field under each post

3. If the field is empty, enter https://waxxbrandz.com/blog-page/ as the canonical URL

4. If no SEO plugin or CMS setting exists, contact your hosting provider or developer to add <link

rel="canonical" href="https://waxxbrandz.com/blog-page/" /> to the page's HTML head tag

5. After saving, use Google Search Console (search.google.com) → URL Inspection tool to test the page and

verify the canonical is recognized

6. Apply the same canonical to all other blog pages to establish a consistent pattern

19. 27 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/blog-page/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your blog page is missing alt text — a short text description that tells both screen readers and

search engines what the image shows. This hurts visitors who use screen readers (accessibility) and makes it
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harder for Google to understand and rank your images in search results.

Why it matters for your business: You're losing SEO ranking signals from 27 images, and excluding blind/low-

vision customers who rely on screen readers to shop your site.

Technical root cause: Images were uploaded without alt attributes filled in, likely during bulk content migration

or manual post creation without an accessibility checklist.

Recommended fix — step by step

1. Open https://waxxbrandz.com/blog-page/ in your browser and identify each image's purpose (product shot,

lifestyle, infographic, etc.)

2. Log into your CMS admin and navigate to the blog post editor

3. For each image, click it and find the 'Alt Text' or 'Description' field

4. Write 5–12 word descriptions that describe what the image shows and its context (e.g., 'Golden Waxx

concentrate in glass jar on marble surface' vs. just 'jar')

5. Save and republish the post

6. After publishing, run the page through https://wave.webaim.org/ to confirm all images now have alt text

7. Set a recurring reminder to add alt text to every new blog image before publishing going forward

20. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/find-us/

Rule: tier2.meta.no-description

What it means (plain English)

Your 'Find Us' page is missing a meta description — the 50–160 character summary that appears below your

page title in Google search results. Without it, Google generates a random snippet from your page, which often

looks unprofessional and doesn't tell customers what to expect.

Why it matters for your business: Missing meta descriptions lower click-through rates from search results;

customers see a generic auto-generated snippet instead of a clear call-to-action about your locations or

contact info, reducing foot traffic and online inquiries.

Technical root cause: The page HTML lacks a <meta name="description" content="..."> tag in the <head>

section, so search engines have no curator-written summary to display.

Recommended fix — step by step

1. Open https://waxxbrandz.com/find-us/ in your browser, right-click → Inspect → search for <meta

name="description" to confirm it's absent

2. Log into your CMS or hosting control panel and locate the 'Find Us' or 'Locations' page editor

3. Find the 'SEO' or 'Meta Description' field (often labeled 'Page Description' or 'Search Preview') — if your

CMS is WordPress, install Yoast SEO plugin → edit page → scroll to 'Yoast SEO' box → paste your

description in the 'Meta description' field

4. Write a 50–160 character description: e.g., 'Visit Waxx Brandz dispensaries. Find locations, hours, and

directions to our cannabis retail stores near you.'

5. Save and publish the page
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6. Wait 1–2 weeks, then check Google Search Console (google.com/webmasters) → Pages → search for the

URL to verify the description now appears in the snippet preview

21. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/find-us/

Rule: tier2.schema.none

What it means (plain English)

Your product pages, location pages, and other key content are missing JSON-LD schema markup — invisible

code that tells Google what your pages are about. Without it, search engines have to guess whether a page

describes a product, a location, or general information, which means they may not rank you well for relevant

searches.

Why it matters for your business: Cannabis retailers depend heavily on local search ("dispensaries near me")

and product discovery — missing schema markup means Google can't confidently show your locations,

products, or business details in rich search results, losing you foot traffic and online orders.

Technical root cause: No structured data blocks (JSON-LD format) are embedded in the page HTML. This is

typically a content management system configuration or manual implementation gap.

Recommended fix — step by step

1. Audit which pages need schema: product pages (Product schema), location/"Find Us" page (LocalBusiness

+ Organization schema), and homepage (Organization schema).

2. If using WordPress, install the free Yoast SEO or Rank Math plugin → go to Settings → Schema → enable

Organization, LocalBusiness, and Product schema types, then fill in required fields (business name, address,

phone, license number if public-facing).

3. If custom HTML/non-WordPress: add JSON-LD blocks to your page template. Start with Organization

schema in the <head>: include name, address, phone, image, and sameAs social links.

4. For the /find-us/ page specifically, add LocalBusiness schema with your dispensary location(s), hours,

address, phone, and license number (if compliance rules allow public display).

5. For any product/strain pages, add Product schema with name, description, image, and cannabinoid/terpene

details (if you display them).

6. Test each schema block using Google's Rich Results Test (search.google.com/test/rich-results) to confirm

validity.

7. Submit the updated sitemap to Google Search Console → Coverage tab to re-crawl and index enriched

pages.

22. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/find-us/

Rule: tier2.a11y.img-missing-alt
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What it means (plain English)

Every image on your 'Find Us' page is missing alt text — a text description that screen readers use to tell blind

and low-vision customers what they're seeing. Search engines also use alt text to understand and rank images.

Right now, Google and assistive technology users see nothing.

Why it matters for your business: You're losing SEO credit for 20 images, potentially missing search traffic for

product photos and brand visuals. You're also creating barriers for disabled customers trying to shop your

products, which may expose you to accessibility complaints.

Technical root cause: Images were added to the page without descriptive alt attributes in the HTML. This is

typically a content management or template issue where image upload processes don't enforce alt-text entry.

Recommended fix — step by step

1. Open the 'Find Us' page in your CMS or HTML editor and inspect each <img> tag.

2. For product images, write alt text like 'Waxx Brandz strain name in packaging' or 'Cannabis flower in glass

jar'.

3. For location/store photos, use 'Waxx Brandz storefront exterior' or 'Dispensary checkout counter'.

4. For decorative images only (logos, dividers with no info), use alt='' (empty) to tell screen readers to skip

them.

5. If using WordPress, install the free 'Alt Text' plugin or use the built-in image block settings → Advanced →

Alt Text field.

6. Save and check with a free tool like WAVE (wave.webaim.org) to confirm all 20 images now have alt text.

7. Audit your image upload workflow: require staff to fill in alt text before publishing any new image to prevent

recurrence.

23. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/live-diamonds/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include JSON-LD structured data—a standardized format that tells Google what your

content is about. Without it, search engines have to guess whether a page is about a product, a blog post, or

something else entirely. This is especially important for cannabis retail, where accurate categorization affects

visibility in local search results.

Why it matters for your business: Missing schema data reduces the likelihood that your products appear in

Google Shopping, local search results, and rich snippets—costing you qualified traffic from customers actively

searching for specific cannabis products.

Technical root cause: The page HTML does not include <script type="application/ld+json">...</script> blocks

that describe the product, business, or organization. Most CMS platforms require either manual insertion or a

plugin/extension to generate this automatically.

Recommended fix — step by step

1. Install and activate a schema plugin appropriate to your platform (if WordPress, use Yoast SEO Premium or

Rank Math; if Shopify, check if your theme supports schema or use Schema App; if custom HTML/other,

proceed to next step).

https://waxxbrandz.com/live-diamonds/


2. In your plugin settings, enable 'Product Schema' and 'LocalBusiness Schema' types.

3. Map your product fields (name, price, image, description, availability) to schema fields within the plugin UI.

4. For the /live-diamonds/ page specifically, ensure the product schema includes: name, description, image

URL, price, currency (USD), availability (in stock/out of stock).

5. Add Organization schema to your homepage footer or header block, including your business name, address,

phone, license number (if public-facing), and service area.

6. Test the updated pages using Google's Rich Results Test (https://search.google.com/test/rich-results) and

verify no errors appear.

7. Submit the sitemap to Google Search Console to trigger re-crawl.

24. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/live-resin/

Rule: tier2.meta.no-description

What it means (plain English)

Your live-resin product page doesn't have a meta description — the 155-character summary that appears below

your page title in Google search results. Without it, Google generates a random excerpt from your page, which

often looks unprofessional and doesn't tell customers what they're clicking on.

Why it matters for your business: Missing descriptions reduce click-through rates from search results,

meaning fewer customers find your live-resin products even if the page ranks well.

Technical root cause: The <meta name="description" content="...">  tag is absent from the

page's HTML head section. This is typically a template or publishing oversight rather than a technical error.

Recommended fix — step by step

1. Open the page HTML source (right-click → View Page Source, or use your site CMS editor) and locate the

<head>  section.

2. Add this line: <meta name="description" content="Shop premium live resin
cannabis products at Waxx Brandz. Potent, fresh extracts with full terpene
profiles. Browse our selection today.">  (adjust wording to match your brand voice; keep it

150–160 characters).

3. If using WordPress, install Yoast SEO plugin (free version) → go to Posts/Pages → Live Resin page → scroll to

Yoast SEO box → paste your description in the 'Meta description' field.

4. If using a headless CMS or custom platform, ask your developer to populate the description field in the page

template or admin panel.

5. Save and publish.

6. Wait 48–72 hours, then search for 'live resin site:waxxbrandz.com' in Google to verify the description now

appears in the snippet.

25. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)
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Business category: seo

Page URL: https://waxxbrandz.com/live-resin/

Rule: tier2.schema.none

What it means (plain English)

Your product pages (like the live resin page) don't include JSON-LD structured data — machine-readable code

that tells Google what your products are, their prices, and availability. Without it, search engines have to guess

what you're selling, which can hurt how your products appear in search results and shopping features.

Why it matters for your business: Missing schema data reduces your visibility in Google Shopping, product

snippets, and voice search results, directly lowering traffic and online sales for your cannabis products.

Technical root cause: The website lacks JSON-LD script blocks in the page HTML that define product, offer,

and organization schema. Most e-commerce platforms include schema by default or via plugins, but this site

either hasn't implemented it or it's been removed.

Recommended fix — step by step

1. Audit your platform: check if you're using Shopify, WooCommerce, custom PHP, or static HTML — this

determines the implementation path

2. If using Shopify: go to Settings → Apps and channels → check if SEO app is installed; if not, install 'Plug in

SEO' or native Shopify SEO tools, which auto-generate product schema

3. If using WooCommerce: install and activate 'Yoast SEO' or 'RankMath' plugin → go to plugin settings →

enable Product schema → verify it appears on live products using Google's Rich Results Test

(search.google.com/test/rich-results)

4. If custom/static HTML: manually add JSON-LD product schema to each product page's <head> section with

name, description, price, currency, availability, and image — use Google's schema.org/Product template

5. Test each updated page using Google Rich Results Test to confirm schema is valid and recognized

6. Submit the sitemap to Google Search Console to re-index pages with new schema

26. 74 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/live-resin/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Your site has 74 images without alt text — descriptive labels that explain what each image shows to people

using screen readers and to search engines. This makes your site harder to use for visitors with vision

impairments and reduces your visibility in image search results, which drives traffic for cannabis product

photos.

Why it matters for your business: Missing alt text hurts both accessibility compliance (risking legal exposure)

and SEO ranking, especially for product discovery searches where image results are critical for e-commerce

traffic.

Technical root cause: Images were added to the site without alt attributes defined in the HTML img tag. This is

typically a content entry issue where product photos and lifestyle images are uploaded without accompanying

descriptive text.
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Recommended fix — step by step

1. Audit the affected page (live-resin) by right-clicking an image → Inspect → confirm img tags lack alt=

attribute

2. If using a CMS (WordPress, Shopify, etc.), log in and edit each product/gallery image, filling the 'Alt Text'

field with a 1–2 sentence description (e.g., 'Live resin concentrate in glass jar, golden color, 1g package')

3. Prioritize high-traffic pages first: live-resin, product category pages, and homepage hero images

4. For bulk edits on WordPress: install Bulk Image Alt Text plugin (Search → Plugins → Add New → search 'bulk

image alt') to batch-add placeholders, then refine manually

5. On Shopify: navigate to Products → select product → scroll to Media → edit each image's Alt text field

6. Include product name, strain/type, and format (concentrate, flower, edible) in alt text for SEO benefit

7. Test fix with a screen reader: use NVDA (Windows, free) or Safari+VoiceOver (Mac) to verify images now

announce their content

8. Re-run accessibility audit after fixes to confirm count drops to zero

27. 39 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/pre-rolls/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Pre-Rolls page is missing alt text — a short text description that explains what the image

shows. Search engines and screen readers (used by people with vision impairments) rely on alt text to

understand your images. Without it, you're invisible to both.

Why it matters for your business: You're losing SEO rankings for product images, missing out on image

search traffic, and excluding customers who use assistive technology — a compliance risk and lost sales.

Technical root cause: Images were uploaded or coded without alt attributes. This is typically a content

management or template oversight rather than a technical error.

Recommended fix — step by step

1. Audit the Pre-Rolls page source code (right-click → Inspect → search for <img> tags) and note which

images lack alt='' attributes.

2. Write descriptive alt text for each product image: e.g., 'Waxx Brandz Citrus Haze pre-roll joint, 0.5g' (be

specific about strain, product type, and size).

3. If using WordPress: Install Yoast SEO, go to Media Library, filter by missing alt text, and bulk-add alt

descriptions.

4. If using a custom CMS or static HTML: Edit each <img> tag to include alt='[description]'; avoid keyword

stuffing—keep descriptions under 125 characters.

5. After updating, run the page through WAVE (wave.webaim.org) or Lighthouse (Chrome DevTools) to verify all

images now have alt text.

6. Extend the same process to all product pages and hero images site-wide (not just Pre-Rolls).

28. Missing meta description

https://waxxbrandz.com/pre-rolls/


Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/product/

Rule: tier2.meta.no-description

What it means (plain English)

Your product pages are missing meta descriptions — the 155-character summary that appears under your site

link in Google search results. Without these, Google generates a generic snippet from your page content, which

often looks unprofessional and fails to encourage clicks. This directly reduces traffic from search results.

Why it matters for your business: Missing meta descriptions lower click-through rates from search engines,

meaning fewer customers discover your products even when you rank for relevant terms like 'indica flower' or

'vape cartridges.'

Technical root cause: The product template lacks a meta description tag in the <head> section of the HTML.

Most platforms either require manual entry per page or need a dynamic template rule to auto-generate them

from product names/summaries.

Recommended fix — step by step

1. Log into your site's admin panel and navigate to the product editing interface

2. If you use WordPress + WooCommerce, install Yoast SEO (free) via Plugins → Add New, search 'Yoast SEO',

install and activate

3. In Yoast SEO, each product's edit screen will show a 'Snippet Preview' box; click 'Edit Snippet' and write a

unique 150–160 character description (e.g., 'Premium hybrid flower with 22% THC. Hand-trimmed, small-

batch. Lab-tested for quality and potency.')

4. If using Shopify, go to Products → select a product → edit the 'Search engine listing' section and fill in the

meta description field

5. If using custom HTML/platform unknown, add <meta name="description" content="[unique 150-160 char

text]"> to every product page's <head> tag

6. After updating 3–5 products, monitor Google Search Console (search.google.com) → Coverage and

Performance tabs to confirm snippets update within 1–2 weeks

29. 43 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/product/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every product image on your site is missing alt text — a text description that screen readers announce to

visually impaired visitors and that search engines use to understand what's in the image. With 43 images

affected, you're blocking both accessibility and SEO value. This is especially important for cannabis products

where visual appeal drives sales but legal compliance requires clear product identification.

Why it matters for your business: Visually impaired customers cannot understand your product offerings,

reducing conversions and creating legal liability under ADA. Search engines also rank product pages lower when

images lack descriptions, hurting organic traffic and discoverability.
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Technical root cause: Product images were added to the page without alt attributes in the HTML. This is

commonly caused by uploading images via a CMS or page builder without filling in the alt-text field during

upload.

Recommended fix — step by step

1. Identify your CMS or page builder (WordPress, Shopify, custom platform, etc.) by inspecting the product

page source or admin login URL

2. If WordPress: Install Yoast SEO plugin → navigate to Media Library → bulk-edit images and add descriptive

alt text for each product (e.g., 'Waxx Brandz Watermelon OG Pre-Roll – 1g Cannabis Product')

3. If Shopify: Open Products → edit each product → click product image → add alt text in the 'Alt text' field

below the upload

4. If custom platform: Request your developer or hosting provider add alt attributes matching this template:

<img src='product.jpg' alt='[Brand] [Product Name] – [Type/Strain] [Package Size]'>

5. For each image, write clear, product-specific alt text (not just 'image' or 'photo') that includes the product

name and key identifiers — avoid keyword stuffing

6. After updating all 43 images, run Waxx Brandz through WebAIM's WAVE tool (https://wave.webaim.org) to

verify alt text is now present

7. Set a process: require alt text on upload going forward; add a pre-launch checklist for new product pages

30. 5 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: accessibility

Page URL: https://waxxbrandz.com/verify/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Five images on your age-verification page have no alt text—a description that screen readers use to understand

images, and that search engines use to index visual content. This means customers using accessibility tools

(like screen readers for vision impairment) can't see what those images show, and Google has no text clue

about their content.

Why it matters for your business: You're losing accessibility compliance points, which could expose you to

ADA liability; you're also missing SEO signals that could help those images rank in image search and boost page

relevance.

Technical root cause: The images on the /verify/ page were added without alt attributes in the HTML. This is

commonly caused by CMS image insertion without filling the alt field, or direct HTML coding that omits the alt

parameter.

Recommended fix — step by step

1. Open https://waxxbrandz.com/verify/ in your browser and right-click on each image → Inspect (or press F12)

to view the HTML.

2. Note which images are missing alt= attributes (or have alt="").

3. If using a CMS (WordPress, Webflow, Shopify, etc.): log in, navigate to Media or the /verify/ page editor, find

each image, and fill the 'Alt Text' field with a brief, descriptive phrase (e.g., 'Age verification document scan'

or 'ID card placeholder').

4. If editing HTML directly: add alt="[description]" to each <img> tag. Example: <img src="id-scan.jpg" alt="ID

card verification example">.
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5. For the age-verification page specifically, alt text should describe the image type (e.g., 'Driver's license

image', 'Passport scan'), not just 'image'.

6. Save changes and reload the page.

7. Run the page through WAVE (wave.webaim.org) or Axe DevTools (browser extension) to confirm all images

now have alt text.

31. Missing canonical

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/waxx-authentic-product/

Rule: tier2.meta.no-canonical

What it means (plain English)

Your product page doesn't tell search engines which version of the URL is the 'official' one. Without this signal,

Google may index duplicate or near-duplicate versions of the same page (like with or without trailing slashes, or

query parameters), splitting your search traffic across multiple URLs instead of consolidating it into one.

Why it matters for your business: Search engines may rank a lower-quality version of your product page, or

dilute your ranking power by splitting traffic across variants—directly reducing how often customers find this

product in search results.

Technical root cause: The page is missing a <link rel="canonical" href="..."> tag in the HTML <head>. Without

it, search engines use heuristics to guess which URL should be the primary one, which is unreliable.

Recommended fix — step by step

1. Open the page source of https://waxxbrandz.com/waxx-authentic-product/ and locate the <head> section

2. Add this line before the closing </head> tag: <link rel="canonical" href="https://waxxbrandz.com/waxx-

authentic-product/">

3. Verify the canonical URL matches the actual URL you want indexed (check for trailing slashes, http vs https,

and www vs non-www consistency)

4. Apply the same fix to all product pages and category pages on the site

5. Use Google Search Console (search.google.com → your site → Pages → Alternate versions) to confirm

Search Console recognizes your canonical tags within 1–2 weeks

6. If you use a CMS (WordPress, Shopify, etc.), enable automatic canonical generation in settings or a plugin

like Yoast SEO (WordPress) or native SEO settings (Shopify) instead of hardcoding each page

32. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/our-blog/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)
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Every image on your blog page lacks alternative text (alt text) — a short text description that appears if an

image doesn't load and is read aloud by screen readers used by people with vision disabilities. This affects both

accessibility for customers and how search engines understand your content.

Why it matters for your business: Missing alt text limits your blog's SEO ranking potential, reduces traffic

from image search, and excludes customers using assistive technology — shrinking your addressable market

and exposing you to accessibility compliance risk.

Technical root cause: Images were added to the blog without filling in the alt text field during upload or

editing. This is common when content is published quickly without a checklist.

Recommended fix — step by step

1. Log in to your site's admin panel and navigate to the blog page editor (likely /wp-admin/post.php or your

CMS equivalent).

2. Open each image in the editor by clicking it; a properties panel should appear.

3. In the 'Alt Text' field, write a 1–2 sentence description of what the image shows (e.g., 'Golden-hued cannabis

flower bud on white background' or 'Customer enjoying Waxx Brandz product in retail setting').

4. For product images, include the product name and key visual detail; for lifestyle photos, describe the scene

and context.

5. Save or publish the post after each image is updated.

6. Once complete, run a free accessibility checker like WAVE (wave.webaim.org) or axe DevTools on the blog

page to confirm all images now have alt text.

7. Add a task to your content workflow: 'Review alt text before publishing' to prevent this on future posts.

33. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/category/industry/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your category pages lacks alternative text—a text description that screen readers use to

describe images to visually impaired visitors, and that search engines use to understand image content. This

means 20% of your page content is invisible to both accessibility tools and search bots. For a brand-focused

cannabis retailer, product photos without descriptions are especially costly.

Why it matters for your business: You're losing SEO credit for product imagery, reducing discoverability in

image search results, and excluding customers with visual impairments from your product catalog—a legal risk

under ADA and a missed market segment.

Technical root cause: Images were added to the page without the HTML alt attribute populated. This is

common when using page builders or uploading bulk product photos without filling in the alt field.

Recommended fix — step by step

1. Open https://waxxbrandz.com/category/industry/ in your browser and inspect the page source (right-click >

Inspect > search for <img) to confirm the alt attributes are empty or missing.

2. Identify your CMS or site builder: check the page footer or browser Network tab for clues (Shopify,

WordPress, custom, etc.).

https://waxxbrandz.com/category/industry/
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3. If WordPress: install Yoast SEO plugin (free), go to Tools > Bulk Editor, filter by 'missing alt', and bulk-edit

each image to add descriptive alt text (e.g., 'Waxx Brandz Berry Blast Edible 100mg').

4. If Shopify: go to Products, select each product shown on that category page, click the product image, and

fill in the 'Alt text' field with a 5–10 word description.

5. If custom/unknown: contact your hosting provider or developer and request they add alt text to all img tags,

using descriptions like '[Product Name] – [Key Descriptor]' (e.g., 'Waxx Brandz Cartridge – Sativa 1g').

6. After adding alt text, re-crawl the page using Google Search Console (go to Google Search Console > URL

Inspection > paste the URL > Inspect) to confirm changes are live.

7. Repeat this process for all category and product pages, not just /industry/.

34. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/category/guides/

Rule: tier2.meta.no-description

What it means (plain English)

Your guides category page is missing a meta description — the short summary that appears under your page

title in Google search results. Without it, Google generates a random excerpt from your page content, which

often looks unprofessional and doesn't tell potential customers what to expect.

Why it matters for your business: Lower click-through rates from search results, since users can't see a clear,

compelling summary of your guides before visiting; this directly reduces organic traffic to a high-intent page.

Technical root cause: The page's HTML <head> section is missing a <meta name="description" content="...">

tag, so search engines have no explicit instruction on what summary to display.

Recommended fix — step by step

1. Log in to your website's admin panel or content management system

2. Navigate to the Guides category page settings or editing interface

3. Find the 'Meta Description' field (or SEO panel if using a plugin like Yoast SEO, All in One SEO, or Rank Math)

4. Write a 150–160 character description that includes your brand name, the word 'guides,' and a benefit —

example: 'Waxx Brandz cannabis guides. Learn about strains, effects, consumption methods, and industry

news.'

5. Save and publish the change

6. Wait 1–2 weeks for Google to recrawl and display the new description in search results

35. Missing canonical

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/category/guides/

Rule: tier2.meta.no-canonical

What it means (plain English)
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Your category page (/category/guides/) doesn't tell search engines which version is the 'official' one. If this

page is accessible via multiple URLs (like with or without trailing slashes, or via different navigation paths),

Google may split its ranking power across duplicates instead of consolidating it to one canonical source.

Why it matters for your business: Without canonical tags, search engines may index multiple versions of the

same page separately, diluting your visibility for 'cannabis guides' and related searches that could drive traffic

to your dispensary.

Technical root cause: The page lacks a <link rel="canonical"

href="https://waxxbrandz.com/category/guides/"> tag in the <head> section. Content management systems

(especially WordPress) should add this automatically, but it may be disabled or misconfigured.

Recommended fix — step by step

1. Inspect the page source (right-click → View Page Source) and search for 'canonical' to confirm it's missing.

2. If running WordPress: Log in → Settings → Reading, verify 'Search engine visibility' is unchecked (if checked,

it blocks indexing entirely). Then install Yoast SEO plugin (free version) → go to each category/guides page

→ 'SEO' tab → scroll to 'Advanced' → set 'Canonical URL' to https://waxxbrandz.com/category/guides/.

3. If not WordPress, add this line to the <head> of /category/guides/ (and all category pages): <link

rel="canonical" href="https://waxxbrandz.com/category/guides/"/>

4. Audit other category and archive pages (/category/, /tag/, etc.) and apply the same canonical tag to each.

5. Submit the updated sitemap to Google Search Console → Coverage → to re-crawl and re-index the

canonical versions.

36. Missing meta description

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/category/disposable-vapes/

Rule: tier2.meta.no-description

What it means (plain English)

Your category page for disposable vapes doesn't have a meta description — that's the 155-character summary

that appears below your page title in Google search results. Without it, Google will auto-generate a snippet,

which often looks choppy and doesn't sell your products. This is especially important for cannabis retail, where

your search listing needs to build trust and clarify what you offer.

Why it matters for your business: Missing meta descriptions reduce click-through rates from search results;

potential customers see a generic excerpt instead of your curated message, and you lose an opportunity to

highlight compliance badges, product range, or unique selling points.

Technical root cause: The category archive template (or individual page metadata) lacks a hand-written

description field populated in the page's <meta name="description" content="..."> tag.

Recommended fix — step by step

1. Log into your site's admin / CMS backend and navigate to the category page editor for Disposable Vapes.

2. Look for a 'Meta Description' field (often below the main title or in an SEO sidebar); if using WordPress,

install Yoast SEO plugin and find the snippet editor in the post/page panel.

3. Write a 150–160 character description that includes your key message, e.g., 'Shop premium disposable

vapes at Waxx Brandz. Lab-tested, legally compliant products. Fast delivery to [your service areas].'
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4. Repeat this process for all other category pages (edibles, flower, etc.) to ensure consistent search

appearance.

5. Save and publish the change.

6. After 1–2 weeks, check Google Search Console → Performance to confirm the description appears in search

results for that URL.

37. Missing canonical

Severity: P2 | Priority: 🟠  HIGH

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/category/disposable-vapes/

Rule: tier2.meta.no-canonical

What it means (plain English)

This page lacks a canonical tag — a line of code that tells Google which version of a page is the 'official' one.

Without it, search engines may not know if this category page is the primary version or a duplicate of another

page, which can dilute your ranking power across multiple URLs.

Why it matters for your business: Duplicate or unclear pages confuse Google's indexing, causing your

disposable vapes category to rank lower in search results and losing potential customer traffic from product

searches.

Technical root cause: The page template or WordPress/CMS configuration does not automatically generate or

manually include the canonical link element in the <head> section, leaving the page ambiguous to search

engines.

Recommended fix — step by step

1. Open the page source (right-click → View Page Source) and check if <link rel="canonical"> exists in the

<head> section; if not, proceed to step 2.

2. If using WordPress, install Yoast SEO or Rank Math plugin (both free versions support canonical tags).

3. In the plugin settings, enable 'Canonical URLs' under SEO settings and set the canonical URL format to

'Post/Page URL'.

4. Go to the disposable vapes category page editor, scroll to the plugin's SEO box, and confirm the canonical

points to https://waxxbrandz.com/category/disposable-vapes/

5. If not using WordPress, add <link rel="canonical" href="https://waxxbrandz.com/category/disposable-

vapes/"> manually in the <head> section of the template file.

6. Verify the fix by re-checking the page source and confirming the canonical tag appears above the closing

</head> tag.

38. No JSON-LD schema

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/category/disposable-vapes/

Rule: tier2.schema.none

What it means (plain English)
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Your product pages are missing structured data — machine-readable code that tells Google exactly what

products you sell, their prices, and availability. Without it, search engines have to guess what your pages are

about, which hurts your visibility in product search results and Google Shopping.

Why it matters for your business: Customers searching for 'disposable vapes near me' or specific product

names may never find your category pages because Google can't confidently rank them; you're leaving traffic

and sales on the table.

Technical root cause: The category page contains HTML product markup but no JSON-LD schema.org blocks

(like Product, PriceSpecification, or LocalBusiness) that explicitly describe inventory, pricing, and compliance

info to search engines.

Recommended fix — step by step

1. Audit your site structure: identify all product category pages and individual product pages that need schema

(at minimum: /category/disposable-vapes/, /category/flower/, etc.)

2. Add Product schema to each product listing page — include name, description, price, currency (USD),

availability (in stock/out of stock), and image URL; use schema.org/Product as the base type

3. For category pages, add CollectionPage schema wrapping the product list, with hasPart pointing to each

product's schema

4. Test your schema in Google's Rich Results Test (https://search.google.com/test/rich-results) — paste your

page URL and verify zero errors

5. If using WordPress with a WooCommerce store, install Yoast SEO or All in One SEO and enable their

structured data modules for products

6. If using custom HTML/PHP, hand-code JSON-LD blocks in the <head> or footer; validate against

https://schema.org/Product and https://schema.org/LocalBusiness for dispensary compliance

7. Submit your updated sitemap to Google Search Console and monitor Search Results report for new 'Product'

rich snippet appearances over 2–4 weeks

39. 20 image(s) missing alt text

Severity: P2 | Priority: 🟠  HIGH

Effort: Moderate (1-3 hours)

Business category: accessibility

Page URL: https://waxxbrandz.com/category/disposable-vapes/

Rule: tier2.a11y.img-missing-alt

What it means (plain English)

Every image on your Disposable Vapes category page is missing alt text—a short text description that describes

what the image shows. Screen readers (tools blind and low-vision visitors use to browse the web) can't

understand images without alt text, so these visitors get no information about your products. Search engines

also use alt text to understand your images, so missing alt text hurts your ability to rank in Google Images and

product searches.

Why it matters for your business: You're losing sales from disabled customers who can't identify products,

and losing organic search traffic from Google Images—a significant traffic source for retail cannabis sites.

Technical root cause: Images were uploaded or embedded without alt text attributes. This is common in

WordPress galleries, Shopify product uploads, or manual HTML when the CMS doesn't enforce alt text as

required.

Recommended fix — step by step
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1. Identify your platform: check the page source (right-click → View Page Source, search for 'wp-content' for

WordPress, 'cdn.shopify.com' for Shopify, or 'squarespace' for Squarespace) to confirm your CMS

2. If WordPress: install the free Yoast SEO or Rank Math plugin → go to the Disposable Vapes page in the editor

→ click each image thumbnail and fill the 'Alt text' field with a 5–10 word description (e.g., 'Blue raspberry

disposable vape pen with 2g capacity')

3. If Shopify: navigate to Products → Disposables collection → edit each product → scroll to Images → click

Edit Alt Text for each image → write a concise product-focused description

4. If another platform: open the product edit page, locate the image properties/settings panel, and add alt text

following this pattern: '[Product name] [key attribute] [format]' (e.g., 'Waxx Brandz strawberry haze

disposable vape')

5. Prioritize high-traffic/conversion products first: if you have bestsellers or featured items in that category, alt

those images first

6. Avoid keyword stuffing: write for humans (describe the image honestly) not search engines—e.g.,

'disposable vape pen' not 'disposable vape pen disposable vape pen cheap'

7. After updating, run the page through WAVE (wave.webaim.org) or axe DevTools (free browser extension) to

confirm all 20 images now have alt text

40. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/industry/trends/

Rule: tier2.schema.none

What it means (plain English)

Your product pages and blog posts don't have JSON-LD schema markup—this is invisible code that tells Google

what your content is about (e.g., a product, article, or business). Without it, search engines have to guess,

which means they may not show rich snippets (like star ratings, prices, or excerpts) in search results, and they

can't understand your page's purpose as clearly.

Why it matters for your business: Missing schema reduces your visibility in search results and makes it harder

for potential customers to find your products when they search for cannabis brands or strains on Google.

Technical root cause: The page HTML does not include JSON-LD script blocks in the head or body. This is

most commonly an omission during site setup or a gap in CMS configuration.

Recommended fix — step by step

1. Identify your most important page types: product pages, blog articles (like the trends page), category

pages, and your homepage.

2. For the trends article page, add a JSON-LD Article schema block to the <head>: use

https://schema.org/Article with properties like headline, datePublished, author, and image.

3. For product/strain pages, add a Product schema block including name, description, image, and availability (if

you sell online) or LocalBusiness markup (if you're dispensary-only).

4. For your dispensary location and business info, add an Organization and/or LocalBusiness schema to your

homepage or contact page.

5. Test each schema block using Google's Rich Results Test (https://search.google.com/test/rich-results) to

ensure no errors.
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6. If you use WordPress, install the Yoast SEO or RankMath plugin, enable schema generation, and configure

each post type (product, article) with the correct schema.

7. If you use Shopify, use built-in schema settings or install a schema app; if custom HTML, manually insert

JSON-LD blocks and test.

8. Re-submit your site to Google Search Console (Coverage → Valid pages) to trigger re-crawl and rich result

processing.

41. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/industry/market-growth/

Rule: tier2.meta.no-description

What it means (plain English)

Your page about market growth has no meta description — the 160-character preview that appears below your

page title in Google search results. Search engines will auto-generate one from your page content, which often

looks choppy or incomplete. This is a fixable issue that costs nothing to address.

Why it matters for your business: Missing descriptions reduce click-through rates from search results;

potential customers may skip your page in favor of competitors with clearer descriptions, directly hurting traffic

to informational content that builds trust and authority.

Technical root cause: The page HTML is missing a <meta name="description" content="...">
tag in the head section. Without it, search engines guess what the page is about.

Recommended fix — step by step

1. Navigate to the page editor for https://waxxbrandz.com/industry/market-growth/ in your CMS.

2. Find the SEO or meta section (often labeled 'Page Settings,' 'SEO,' or 'Meta Tags').

3. In the 'Meta Description' field, write a 155–160 character sentence that summarizes the page: e.g., 'Explore

cannabis industry growth trends, market forecasts, and expansion opportunities for 2024 and beyond.'

4. Include 1–2 keywords naturally (e.g., 'cannabis market growth,' 'industry trends').

5. Save and publish the page.

6. Wait 1–2 weeks, then check Google Search Console (search-console.google.com) → Pages to verify Google

has re-indexed the page with your new description.

42. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/industry/market-growth/

Rule: tier2.schema.none

What it means (plain English)

Your website is missing JSON-LD structured data—a machine-readable format that tells Google what your

pages contain (e.g., product details, business hours, reviews). Without it, search engines have to guess the
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meaning of your content, which often leads to missed opportunities for rich search results like star ratings,

pricing, or availability badges.

Why it matters for your business: Missing schema markup reduces your chances of appearing in Google's

rich snippets and Knowledge Panel features, which drive clicks and trust—especially important for cannabis

retail where product info (strain, THC%, price) and licensing details build customer confidence.

Technical root cause: The page lacks JSON-LD blocks in its HTML source. This is typically a CMS

configuration or template issue where schema markup was never implemented during site setup.

Recommended fix — step by step

1. Audit your site architecture: identify high-value page types (product pages, business/location pages, blog

articles). Prioritize product and location pages first.

2. Use Google's Structured Data Markup Helper (https://www.google.com/webmasters/markup-helper/) to

generate Organization and LocalBusiness schema for your homepage.

3. For product pages: add Product + AggregateOffer schema including name, description, image, price,

availability, and THC/CBD info if available.

4. For location/hours pages: add LocalBusiness schema with address, phone, hours, license number (if public-

facing), and service area.

5. Install Yoast SEO or RankMath plugin (if WordPress), enable schema features in settings, and configure

Business type + product schema templates.

6. If custom platform: manually add JSON-LD blocks to page templates before the closing </head> tag; use

Google's Structured Data Tester (https://validator.schema.org/) to validate.

7. Submit updated pages to Google Search Console (Coverage > Enhance > Rich Results) to request re-crawl.

43. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/

Rule: tier2.schema.none

What it means (plain English)

Your product and guide pages don't include JSON-LD structured data—machine-readable code that tells

Google what your content is about. Without it, search engines can't easily understand that you're a cannabis

retailer with specific products, reviews, and compliance info, so they can't display rich results (like star ratings

or product snippets) in search results.

Why it matters for your business: Missing schema reduces your visibility in Google Search results and

eliminates opportunities to display product ratings, pricing, or availability directly in search—features that drive

clicks and qualified traffic to cannabis retailers.

Technical root cause: No JSON-LD markup has been added to the page HTML. This is a code-level addition

that requires either manual insertion in the page template or a plugin/tool to generate and inject it automatically.

Recommended fix — step by step

1. Audit your site structure: identify key page types (product pages, blog/guide pages, local business info) that

would benefit most from schema.

2. If using WordPress: install Yoast SEO or Rank Math, go to the plugin settings → Schema → enable Product

schema for product pages and Article schema for guides.
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3. If using a static site or custom platform: add LocalBusiness + Organization schema to your homepage

footer/header template, and Product + Review schema to each product page, using

schema.org/LocalBusiness and schema.org/Product as templates.

4. Test your markup: paste your URL into Google's Rich Results Test (google.com/webmasters/markup-helper)

to validate the schema is present and valid.

5. Prioritize schema for: (1) your homepage (Organization + LocalBusiness), (2) product pages (Product +

Review), (3) blog guides (Article + BreadcrumbList).

6. Once live, monitor Google Search Console → Coverage tab to ensure Google is indexing your pages with the

schema intact.

44. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/blog-page/

Rule: tier2.schema.none

What it means (plain English)

Your blog page doesn't include JSON-LD structured data — invisible code that tells search engines what your

content is about. Without it, Google can't reliably understand whether a page is a product listing, article, or

local business info, so it may rank lower or display less helpful search results (like missing star ratings or

snippets).

Why it matters for your business: Missing schema markup reduces your visibility in Google search results for

cannabis product and educational content, which directly impacts discoverability by customers searching for

strains, effects, or dispensary info.

Technical root cause: The blog page HTML lacks <script type="application/ld+json"> blocks that define

content type, author, publication date, and other metadata that search engines use to index and display results

correctly.

Recommended fix — step by step

1. Install the Yoast SEO plugin (if WordPress) or equivalent schema tool for your platform

2. Navigate to the blog post editor and confirm 'Article' schema is enabled in the SEO sidebar

3. Verify fields are auto-filled: headline, publication date, author, featured image

4. Use Google's Rich Results Test (https://search.google.com/test/rich-results) to paste your blog URL and

confirm schema is now detected

5. For product pages (if applicable), add Product schema with cannabinoid info, price, and availability

6. If not on WordPress, manually add <script type="application/ld+json"> blocks to your blog template with

Article schema from schema.org/Article

45. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/product/
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Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include structured data—machine-readable code that tells search engines (Google,

Bing) what your products are, their prices, ratings, and availability. Without it, search engines have to guess at

your content, which means your products may not appear in rich results (product cards with ratings, prices,

availability badges) that shoppers see.

Why it matters for your business: Missing structured data reduces your visibility in search results where

customers are actively shopping, especially for cannabis products where trust signals like ratings and verified

availability matter.

Technical root cause: The product page HTML lacks JSON-LD blocks (typically in the <head> or near product

content) that formally declare product name, price, image, rating, and in-stock status to search engines.

Recommended fix — step by step

1. Audit your product template: view the HTML source of https://waxxbrandz.com/product/ (Ctrl+U / Cmd+U),

search for '<script type="application/ld+json">' — confirm none exist for Product schema.

2. If using WordPress, install Yoast SEO (free version) → go to Yoast SEO → Integrations → confirm 'Schema' is

enabled, then edit a product post and check the 'Schema' tab to auto-generate Product schema; publish

and re-check source code.

3. If using Shopify, go to Sales channels → Online store → Preferences → scroll to 'Search engine listing

preview' and ensure 'Product schema' toggle is ON; Shopify auto-generates this, so verify in page source.

4. If custom-built, add a JSON-LD Product schema block to each product page template (include name, image,

price, currency, availability, rating if available) — use Google's Structured Data Testing Tool

(search.google.com/test/rich-results) to validate before deploy.

5. After adding schema, wait 2–3 weeks, then use Google Search Console → Enhancements → 'Rich results' to

monitor indexing and surface any errors.

46. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/verify/

Rule: tier2.meta.no-description

What it means (plain English)

The /verify/ page is missing a meta description — the short text snippet (150–160 characters) that search

engines display under your page title in results. Without it, Google may auto-generate a snippet that doesn't

represent your content well, which can hurt click-through rates.

Why it matters for your business: Fewer clicks from search results means less traffic to your age-verification

gate, reducing customer acquisition and visibility for your dispensary's online presence.

Technical root cause: The HTML <head> tag on /verify/ does not include a <meta name="description"

content="..."> element. This is typically missing because the page template wasn't configured with one, or it

was accidentally removed during development.

Recommended fix — step by step
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1. Inspect the /verify/ page source (right-click → View Page Source, or use a web inspector) and look for the

<head> section.

2. Add a meta description tag immediately after the <title> tag: <meta name="description" content="Age

verification required to access Waxx Brandz. You must be 21+ to continue."> (adjust wording as needed,

keep under 160 characters).

3. If you use WordPress: install Yoast SEO plugin, go to Dashboard → Yoast SEO → General, then edit the

/verify/ page and fill in the 'Meta description' field in the sidebar.

4. If you use a static site or custom CMS: add the meta description to your page template or HTML file directly.

5. Save and publish the change, then use Google Search Console (search.google.com) → URL Inspection →

paste https://waxxbrandz.com/verify/ to request a re-index within 1–2 days.

47. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/verify/

Rule: tier2.schema.none

What it means (plain English)

Your website doesn't include JSON-LD structured data, which is machine-readable code that tells search

engines what your pages contain. For a cannabis retail site, this means Google can't automatically understand

your product listings, store location, hours, or license information—making it harder for search engines to

display rich snippets (fancy preview cards) in search results.

Why it matters for your business: Without schema markup, your dispensary loses visibility in local search

results and product carousels, reducing qualified traffic from customers actively searching for your products

and location.

Technical root cause: No JSON-LD blocks ( <script type="application/ld+json">  tags) have

been added to the page HTML. This is typically a templating or content management decision rather than a

technical error.

Recommended fix — step by step

1. Add a LocalBusiness schema block to your homepage with store name, address, phone, hours, and license

information (use schema.org/LocalBusiness as the template)

2. Add a Product schema to each product/strain detail page listing THC/CBD content, price, and availability

3. Add an Organization schema to your footer or homepage with business name, logo, social profiles, and

license credentials

4. Use Google's Structured Data Testing Tool (search.google.com/test/rich-results) to validate each schema

block before publishing

5. If using WordPress, install Yoast SEO or RankMath, enable their schema features, and configure

LocalBusiness + Product blocks via the plugin UI

48. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo
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Page URL: https://waxxbrandz.com/waxx-authentic-product/

Rule: tier2.schema.none

What it means (plain English)

Your product pages don't include JSON-LD structured data — machine-readable code that tells search engines

what your products are, their prices, and availability. Without it, Google can't easily understand your inventory in

search results or voice search.

Why it matters for your business: Missing schema reduces your chances of appearing in Google Shopping,

voice search results, and rich snippets (star ratings, price, stock status), which drive qualified traffic to

dispensaries.

Technical root cause: The page HTML lacks <script type="application/ld+json"> blocks that describe

products, local business info, and aggregate ratings in a standardized format search engines recognize.

Recommended fix — step by step

1. Audit which pages need schema: product pages, about/location page, and homepage

2. Install a schema plugin: if WordPress, use Yoast SEO or Schema Pro; go to Plugins → Add New → search

'schema' → install and activate

3. Configure Product schema for each product page: set product name, price, description, image, and

availability (in-stock/out-of-stock)

4. Add LocalBusiness schema to your contact/location page with business name, address, phone, hours, and

license number if public

5. Test schema output: paste your product URL into Google's Rich Results Test (search.google.com/test/rich-

results) and verify all fields appear

6. Monitor: in Google Search Console → Enhancements, check for schema errors or warnings monthly

49. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/our-blog/

Rule: tier2.meta.no-description

What it means (plain English)

Your blog index page (/our-blog/) is missing a meta description — the 155-character text snippet that appears

below your page title in Google search results. This means Google will auto-generate a description from your

page content, which is often choppy and doesn't highlight what makes your content compelling.

Why it matters for your business: Without a custom description, your blog posts are less likely to get clicks

from search results, reducing organic traffic and brand visibility for educational content that builds trust with

customers.

Technical root cause: The <meta name="description" content="..."> tag is not present in the HTML <head> of

the page. If your site uses a CMS, the blog index template likely has no description field filled in.

Recommended fix — step by step

1. Log in to your site admin and navigate to the /our-blog/ page settings or SEO meta fields.

2. Add a meta description of 150–160 characters. Example: 'Explore cannabis education, product reviews, and

industry news from Waxx Brandz. Stay informed on strains, consumption, and wellness trends.'

https://waxxbrandz.com/waxx-authentic-product/
https://waxxbrandz.com/our-blog/


3. If you use WordPress, install Yoast SEO (free) or RankMath, then edit the blog archive page and fill the 'SEO

Title & Meta Description' box.

4. If you use Shopify, go to Online Store > Pages, click 'our-blog' collection, scroll to 'Search engine listing

preview', and add the description.

5. If your site is custom HTML/Node.js, add <meta name="description" content="Your description here"> in

the <head> tag of the blog template.

6. Test the change by visiting https://waxxbrandz.com/our-blog/ in an incognito window and checking the page

source (Ctrl+U or Cmd+U), or use Google Search Console Preview to see the rendered snippet.

50. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/our-blog/

Rule: tier2.schema.none

What it means (plain English)

Your blog page doesn't include JSON-LD structured data — a standardized format that tells search engines

what your content is about. Without it, Google has to guess whether a page is a product listing, a news article,

or just general information. This is especially important for cannabis retail sites, where search engines apply

extra scrutiny to your content.

Why it matters for your business: Missing schema markup reduces the chance that Google will display your

blog posts in search results with rich snippets (like star ratings or publication dates), which dramatically lowers

click-through rates from organic search.

Technical root cause: The page's HTML lacks a <script type="application/ld+json"> block in the <head> or

<body> that defines the page structure. Search engines fall back to guessing content type from HTML tags

alone.

Recommended fix — step by step

1. Install Yoast SEO plugin (if WordPress) or All in One Schema Rich Snippets (if WordPress); if custom HTML,

add a <script type="application/ld+json"> block to /our-blog/ that wraps BlogPosting schema from

schema.org

2. In the schema block, include: @type: "BlogPosting", headline, datePublished, author, image, articleBody (or

description), and mainEntity

3. Validate the schema using Google's Rich Results Test (search.google.com/test/rich-results) and paste the

blog URL to confirm no errors

4. If using Yoast, navigate to SEO → Search Appearance → Schema and enable Article schema for blog posts

5. Monitor Google Search Console (console.google.com) → Enhancements tab to confirm schema is

recognized within 1–2 weeks

51. Missing canonical

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/category/industry/

https://waxxbrandz.com/our-blog/
https://waxxbrandz.com/our-blog/
https://waxxbrandz.com/category/industry/


Rule: tier2.meta.no-canonical

What it means (plain English)

Your category page doesn't have a canonical tag — a HTML instruction that tells search engines which version

of a page is the 'official' one. Without it, Google may not know if this page, a duplicate, or a filtered version

should rank. For a category page that might be accessed via different URLs (with/without trailing slash, with

filters, etc.), this creates confusion.

Why it matters for your business: Search engines may dilute ranking power across multiple versions of this

page, reducing visibility for 'cannabis industry news' or similar queries your customers search for.

Technical root cause: The page lacks a <link rel="canonical"

href="https://waxxbrandz.com/category/industry/"> tag in its HTML head. This is often missing when pages are

generated dynamically or when canonical tagging wasn't part of the site build.

Recommended fix — step by step

1. Open https://waxxbrandz.com/category/industry/ in a browser, right-click → View Page Source, and search

for '<link rel="canonical"' to confirm it's absent.

2. If using WordPress: install Yoast SEO plugin → go to SEO → Titles & Metas → ensure 'Add canonical tags' is

enabled.

3. If not WordPress: add <link rel="canonical" href="https://waxxbrandz.com/category/industry/"> to the

<head> section of this page's HTML template.

4. Apply the same fix to all other category and archive pages on your site (product categories, blog archives,

etc.).

5. Re-crawl the site using Google Search Console (Settings → Request Indexing) to ensure Google picks up the

canonical tags.

52. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/category/guides/

Rule: tier2.schema.none

What it means (plain English)

Your site isn't providing structured data (JSON-LD) — machine-readable information that search engines use to

understand your content. Without it, Google can't easily identify what your guides are about, which limits how

they appear in search results and reduces the chance they'll be featured in rich snippets (special formatted

results).

Why it matters for your business: Missing schema means your educational content ranks lower in search,

reducing organic traffic to your guides — a key asset for building brand authority and driving repeat visits in the

cannabis space.

Technical root cause: No JSON-LD blocks are being output in the page's <head> or <body>. This is typically

absent on sites that haven't implemented structured data markup or are using a platform/theme without schema

support built in.

Recommended fix — step by step

https://waxxbrandz.com/category/industry/%22%3E
https://waxxbrandz.com/category/industry/
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1. Identify your site platform (WordPress, Shopify, custom, etc.) by viewing page source (Ctrl+U) and looking

for wp-content, Shopify assets, or custom framework clues

2. If WordPress: install Yoast SEO or Rank Math plugin → navigate to plugin settings → enable Schema → go to

each guide and fill in the 'Content Type' dropdown and metadata fields

3. If custom/unknown platform: add JSON-LD schema.org/Article blocks to each guide page in the <head> with

fields: headline, description, datePublished, author, image

4. Validate your schema output using Google's Rich Results Test (search.google.com/test/rich-results) on the

/category/guides/ page

5. Monitor Google Search Console → Enhancements → Rich Results report for 30 days post-implementation to

confirm indexing

53. Missing meta description

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/author/692555pwpadmin/

Rule: tier2.meta.no-description

What it means (plain English)

Your author archive page is missing a meta description — the 160-character summary that appears below your

page title in Google search results. Without it, Google generates a generic snippet from your page content,

which often looks unprofessional and doesn't encourage clicks.

Why it matters for your business: Missing meta descriptions reduce click-through rate from search results,

meaning fewer potential customers land on your site even when you rank.

Technical root cause: The author archive page was likely auto-generated by your WordPress theme without a

custom meta description field filled in.

Recommended fix — step by step

1. Log in to WordPress admin dashboard

2. Navigate to Users → All Users and click the author '692555pwpadmin' to open their profile

3. If using Yoast SEO plugin: scroll to 'Snippet Editor' at bottom and add a 160-character description like 'Shop

[author name]'s cannabis products at Waxx Brandz — curated selections of flower, edibles, and more'

4. If not using Yoast: install Yoast SEO (free version), activate it, and repeat step 3

5. Alternatively, go to Settings → Reading and disable author archives entirely if this admin account should not

be publicly featured

6. Save changes and test by searching 'waxxbrandz.com/author/692555pwpadmin/' in Google Search Console

to verify the new snippet appears

54. Missing canonical

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Quick win (< 30 min)

Business category: seo

Page URL: https://waxxbrandz.com/author/692555pwpadmin/

Rule: tier2.meta.no-canonical

https://waxxbrandz.com/author/692555pwpadmin/
https://waxxbrandz.com/author/692555pwpadmin/


What it means (plain English)

Your site has a page (/author/692555pwpadmin/) without a canonical tag — a single line of code that tells

search engines which version of a page is the 'official' one. Without it, search engines may index duplicate or

near-duplicate content, diluting your SEO authority across multiple URLs.

Why it matters for your business: Search engines may split ranking power between similar pages, reducing

your visibility in cannabis product searches and lowering organic traffic to your dispensary site.

Technical root cause: Author archive pages (likely auto-generated by WordPress) are often left without

canonical tags, especially when the site uses pretty permalinks or has multiple content structures.

Recommended fix — step by step

1. Log in to WordPress admin → Settings → Reading, and verify 'Search Engine Visibility' is checked

2. Install Yoast SEO (free version) via Plugins → Add New → search 'Yoast SEO' → Install and Activate

3. Go to Yoast SEO → Tools → Mass Edit → select 'Authors' from dropdown

4. For the 'pwpadmin' author, check if this is a real team member or a leftover admin account; if leftover, delete

the account via Users to avoid indexing it

5. If the account must exist, open Yoast SEO → Search Appearance → Archives → toggle off 'Show author

archives in search results' to prevent indexing entirely

6. Run a Google Search Console crawl (submit the homepage URL) to re-scan and update index within 48

hours

55. No JSON-LD schema

Severity: P2 | Priority: 🟡  MEDIUM

Effort: Moderate (1-3 hours)

Business category: seo

Page URL: https://waxxbrandz.com/author/692555pwpadmin/

Rule: tier2.schema.none

What it means (plain English)

Your site isn't using JSON-LD structured data, which is a machine-readable format that tells search engines

what your pages are about. Without it, Google and other search engines have to guess the meaning of your

content instead of reading explicit signals you provide. This is especially important for cannabis retailers, where

search engines need to understand product types, licensing, and local business details.

Why it matters for your business: Missing schema data reduces your chances of appearing in rich search

results (like product carousels or local business listings), which drives qualified traffic and trust signals that

cannabis-conscious customers look for.

Technical root cause: The page lacks JSON-LD blocks in the HTML head or body. This is typically absent when

a site is built without SEO plugins or custom schema implementation, or when author/archive pages aren't

explicitly configured with structured data.

Recommended fix — step by step

1. Audit which page types exist: products, blog posts, author archives, location pages. Prioritize product and

local business pages.

2. If using WordPress, install Yoast SEO or RankMath plugin (both have free tiers). Go to plugin settings →

Schema → enable LocalBusiness and Product schema templates.

https://waxxbrandz.com/author/692555pwpadmin/


3. If not WordPress or using a custom platform, add JSON-LD blocks manually: insert a <script

type='application/ld+json'> block in the page <head> with Organization, LocalBusiness, or Product schema

(use schema.org as reference).

4. For product pages specifically, include name, description, image, price, availability, and cannabis

license/compliance info in schema.

5. Test with Google's Rich Results Test (search.google.com/test/rich-results) — paste a product page URL and

verify schema is detected.

6. Deploy schema first to 3–5 high-traffic pages (homepage, top products), then expand.

56. Missing meta description

Severity: P2

Page URL: https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

57. 20 image(s) missing alt text

Severity: P2

Page URL: https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

58. Missing meta description

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

59. Missing meta description

Severity: P2

Page URL: https://waxxbrandz.com/blog-page/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

60. Missing meta description

https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/
https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/
https://waxxbrandz.com/
https://waxxbrandz.com/blog-page/


Severity: P2

Page URL: https://waxxbrandz.com/live-diamonds/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

61. 74 image(s) missing alt text

Severity: P2

Page URL: https://waxxbrandz.com/live-diamonds/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

62. Missing meta description

Severity: P2

Page URL: https://waxxbrandz.com/pre-rolls/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

63. No JSON-LD schema

Severity: P2

Page URL: https://waxxbrandz.com/pre-rolls/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

64. Missing meta description

Severity: P2

Page URL: https://waxxbrandz.com/waxx-authentic-product/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

65. Missing meta description

Severity: P2

https://waxxbrandz.com/live-diamonds/
https://waxxbrandz.com/live-diamonds/
https://waxxbrandz.com/pre-rolls/
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Page URL: https://waxxbrandz.com/category/industry/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

66. No JSON-LD schema

Severity: P2

Page URL: https://waxxbrandz.com/category/industry/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

67. 20 image(s) missing alt text

Severity: P2

Page URL: https://waxxbrandz.com/category/guides/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

68. 20 image(s) missing alt text

Severity: P2

Page URL: https://waxxbrandz.com/author/692555pwpadmin/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

69. Missing meta description

Severity: P2

Page URL: https://waxxbrandz.com/author/budauthority/

Rule: tier2.meta.no-description

Detail

Page has no meta description.

70. Missing canonical

Severity: P2

Page URL: https://waxxbrandz.com/author/budauthority/

https://waxxbrandz.com/category/industry/
https://waxxbrandz.com/category/industry/
https://waxxbrandz.com/category/guides/
https://waxxbrandz.com/author/692555pwpadmin/
https://waxxbrandz.com/author/budauthority/
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Rule: tier2.meta.no-canonical

Detail

Page has no <link rel=canonical>.

71. No JSON-LD schema

Severity: P2

Page URL: https://waxxbrandz.com/author/budauthority/

Rule: tier2.schema.none

Detail

Page has no JSON-LD structured data blocks.

72. 20 image(s) missing alt text

Severity: P2

Page URL: https://waxxbrandz.com/author/budauthority/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

73. No H1 on homepage

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier4.h1.missing

Detail

Every page should have exactly one H1.

74. Missing core schema types: Organization, LocalBusiness, WebSite

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier4.schema.missing-core

Detail

Every site should emit Organization + LocalBusiness + WebSite JSON-LD.

75. Missing security header: strict-transport-security

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier5.header.strict-transport-security

https://waxxbrandz.com/author/budauthority/
https://waxxbrandz.com/author/budauthority/
https://waxxbrandz.com/
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Detail

strict-transport-security not present on homepage response. Affects fortress score and CSP posture.

76. Missing security header: x-frame-options

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier5.header.x-frame-options

Detail

x-frame-options not present on homepage response. Affects fortress score and CSP posture.

77. Missing security header: content-security-policy

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier5.header.content-security-policy

Detail

content-security-policy not present on homepage response. Affects fortress score and CSP posture.

78. 21 tap targets under 44px at mobile-320

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

79. 21 tap targets under 44px at mobile-375

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

80. 21 tap targets under 44px at mobile-414

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier6.a11y.small-targets

Detail

https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/
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Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

81. 14 tap targets under 44px at tablet-768

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier6.a11y.small-targets

Detail

Interactive elements smaller than 44x44 fail WCAG 2.5.5 target size.

82. Lighthouse perf (mobile): 62/100

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier8.lighthouse.perf-mobile

Detail

Score 62 is below target 85. See HTML report for details.

83. Lighthouse bestPractices (desktop): 74/100

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier8.lighthouse.bestPractices-desktop

Detail

Score 74 is below target 90. See HTML report for details.

84. A11y: Heading levels should only increase by one (×2)

Severity: P2

Page URL: https://waxxbrandz.com/

Rule: tier9.a11y.heading-order

Detail

Ensure the order of headings is semantically correct

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/heading-order?application=playwright

85. A11y: All page content should be contained by landmarks

Severity: P2

Page URL: https://waxxbrandz.com/

https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/
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Rule: tier9.a11y.region

Detail

Ensure all page content is contained by landmarks

Impact: moderate

WCAG:

Learn more: https://dequeuniversity.com/rules/axe/4.11/region?application=playwright

P3 — 76 findings

1. Title length 120 chars

Severity: P3

Page URL: https://waxxbrandz.com/industry/trends/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Waxx BrandzTop Cannabis Industry Trends to Watch in 2026: Market Growth,

Innovation, and Consumer Insights – Waxx Brandz"

2. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/industry/trends/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

3. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/industry/trends/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

4. Title length 122 chars

Severity: P3

Page URL: https://waxxbrandz.com/industry/legalization-updates/

Rule: tier2.meta.title-length

https://dequeuniversity.com/rules/axe/4.11/region?application=playwright
https://waxxbrandz.com/industry/trends/
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https://waxxbrandz.com/industry/trends/
https://waxxbrandz.com/industry/legalization-updates/


Detail

Title should be 20-65 chars. Got: "Waxx BrandzCannabis Legalization 2026: The Definitive State-by-State

Guide to Laws, Limits, and Concentrates – Waxx Brandz"

5. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/industry/legalization-updates/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

6. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/industry/legalization-updates/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

7. Title length 119 chars

Severity: P3

Page URL: https://waxxbrandz.com/industry/market-growth/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Waxx BrandzThe Future of Cannabis 2026-2030: Market Forecasts,

Rescheduling, and the Rise of Concentrates – Waxx Brandz"

8. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/industry/market-growth/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

9. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/industry/market-growth/

https://waxxbrandz.com/industry/legalization-updates/
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Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

10. Title length 133 chars

Severity: P3

Page URL: https://waxxbrandz.com/industry/innovation/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Waxx BrandzInnovations Shaping the Cannabis Industry: Advanced

Extraction, Cultivation, and Sustainable Product Quality – Waxx Brandz"

11. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/industry/innovation/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

12. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/industry/innovation/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

13. Title length 91 chars

Severity: P3

Page URL: https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Waxx BrandzLive Resin vs. Live Diamonds: Choosing the Best 2g Disposable

Vape – Waxx Brandz"

14. Missing OpenGraph metadata

Severity: P3

https://waxxbrandz.com/industry/innovation/
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https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/


Page URL: https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

15. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

16. Title length 85 chars

Severity: P3

Page URL: https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Waxx BrandzFake Carts vs. Authentic Vapes: How to Verify Your Waxx Barz –

Waxx Brandz"

17. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

18. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

19. Title length 85 chars

Severity: P3

https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/
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Page URL: https://waxxbrandz.com/disposable-vapes/california/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Waxx BrandzCalifornia’s Benchmark for Premium Flavored Disposable Vapes

– Waxx Brandz"

20. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/disposable-vapes/california/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

21. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/disposable-vapes/california/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

22. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

23. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

24. Missing OpenGraph metadata

Severity: P3

https://waxxbrandz.com/disposable-vapes/california/
https://waxxbrandz.com/disposable-vapes/california/
https://waxxbrandz.com/disposable-vapes/california/
https://waxxbrandz.com/
https://waxxbrandz.com/


Page URL: https://waxxbrandz.com/blog-page/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

25. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/blog-page/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

26. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/find-us/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

27. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/find-us/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

28. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/live-diamonds/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

29. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/live-diamonds/

https://waxxbrandz.com/blog-page/
https://waxxbrandz.com/blog-page/
https://waxxbrandz.com/find-us/
https://waxxbrandz.com/find-us/
https://waxxbrandz.com/live-diamonds/
https://waxxbrandz.com/live-diamonds/


Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

30. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/live-resin/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

31. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/live-resin/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

32. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/pre-rolls/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

33. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/pre-rolls/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

34. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/product/

Rule: tier2.meta.no-og

https://waxxbrandz.com/live-resin/
https://waxxbrandz.com/live-resin/
https://waxxbrandz.com/pre-rolls/
https://waxxbrandz.com/pre-rolls/
https://waxxbrandz.com/product/


Detail

Page missing og:title and/or og:image.

35. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/product/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

36. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/verify/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

37. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/verify/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

38. Title length 4 chars

Severity: P3

Page URL: https://waxxbrandz.com/waxx-authentic-product/

Rule: tier2.meta.title-length

Detail

Title should be 20-65 chars. Got: "Waxx"

39. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/waxx-authentic-product/

Rule: tier2.meta.no-og

Detail

https://waxxbrandz.com/product/
https://waxxbrandz.com/verify/
https://waxxbrandz.com/verify/
https://waxxbrandz.com/waxx-authentic-product/
https://waxxbrandz.com/waxx-authentic-product/


Page missing og:title and/or og:image.

40. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/waxx-authentic-product/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

41. 1 image(s) missing alt text

Severity: P3

Page URL: https://waxxbrandz.com/waxx-authentic-product/

Rule: tier2.a11y.img-missing-alt

Detail

Images without alt fail a11y + hurt SEO.

42. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/our-blog/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

43. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/our-blog/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

44. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/category/industry/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

https://waxxbrandz.com/waxx-authentic-product/
https://waxxbrandz.com/waxx-authentic-product/
https://waxxbrandz.com/our-blog/
https://waxxbrandz.com/our-blog/
https://waxxbrandz.com/category/industry/


45. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/category/industry/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

46. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/category/guides/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

47. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/category/guides/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

48. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/category/disposable-vapes/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

49. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/category/disposable-vapes/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

https://waxxbrandz.com/category/industry/
https://waxxbrandz.com/category/guides/
https://waxxbrandz.com/category/guides/
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50. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/author/692555pwpadmin/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

51. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/author/692555pwpadmin/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

52. Missing OpenGraph metadata

Severity: P3

Page URL: https://waxxbrandz.com/author/budauthority/

Rule: tier2.meta.no-og

Detail

Page missing og:title and/or og:image.

53. Missing Twitter card

Severity: P3

Page URL: https://waxxbrandz.com/author/budauthority/

Rule: tier2.meta.no-twitter-card

Detail

No twitter:card meta tag.

54. Heavy page weight (mobile): 116085KB

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier3.weight.total-mobile

Detail

Total transfer exceeds 2500KB budget.

https://waxxbrandz.com/author/692555pwpadmin/
https://waxxbrandz.com/author/692555pwpadmin/
https://waxxbrandz.com/author/budauthority/
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55. Heavy page weight (desktop): 114091KB

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier3.weight.total-desktop

Detail

Total transfer exceeds 2500KB budget.

56. Missing security header: x-content-type-options

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier5.header.x-content-type-options

Detail

x-content-type-options not present on homepage response. Affects fortress score and CSP posture.

57. Missing security header: referrer-policy

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier5.header.referrer-policy

Detail

referrer-policy not present on homepage response. Affects fortress score and CSP posture.

58. Missing security header: permissions-policy

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier5.header.permissions-policy

Detail

permissions-policy not present on homepage response. Affects fortress score and CSP posture.

59. SSL Labs grade: unknown

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier5.fortress.ssl-grade

Detail

Qualys SSL Labs: SSL Labs HTTP 400. Aim for A+ via strong TLS 1.3, HSTS, CAA, and preload.

https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/


60. DNSSEC not enabled

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier5.fortress.dnssec-missing

Detail

DNSSEC adds cryptographic verification to DNS responses. Consider enabling via your registrar.

61. No CAA DNS records

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier5.fortress.caa-missing

Detail

CAA records restrict which CAs may issue certs for your domain, preventing rogue issuance. Add CAA for

letsencrypt.org / digicert.com / etc.

62. DMARC policy is p=none (monitoring only)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier5.fortress.dmarc-weak

Detail

DMARC published at p=none — monitoring mode only. After 2-4 weeks of clean reports, tighten to p=quarantine

→ p=reject.

63. Lighthouse bestPractices (mobile): 79/100

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lighthouse.bestPractices-mobile

Detail

Score 79 is below target 90. See HTML report for details.

64. Lighthouse seo (mobile): 92/100

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lighthouse.seo-mobile

Detail

Score 92 is below target 95. See HTML report for details.

https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/
https://waxxbrandz.com/


65. LH mobile: Preconnect to required origins (Est savings of 340 ms)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.uses-rel-preconnect-mobile

Detail

Consider adding preconnect  or dns-prefetch  resource hints to establish early connections to

important third-party origins. https://developer.chrome.com/docs/lighthouse/performance/uses-rel-

preconnect/" target="_blank" rel="noreferrer">Learn how to preconnect to required origins.

66. LH mobile: Eliminate render-blocking resources (Est savings of

1,190 ms)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.render-blocking-resources-mobile

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

67. LH mobile: Minify JavaScript (Est savings of 5 KiB)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.unminified-javascript-mobile

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

68. LH mobile: Reduce unused CSS (Est savings of 32 KiB)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.unused-css-rules-mobile

Detail

Reduce unused rules from stylesheets and defer CSS not used for above-the-fold content to decrease bytes

consumed by network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-css-rules/"

target="_blank" rel="noreferrer">Learn how to reduce unused CSS.

69. LH mobile: Reduce unused JavaScript (Est savings of 185 KiB)
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Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.unused-javascript-mobile

Detail

Reduce unused JavaScript and defer loading scripts until they are required to decrease bytes consumed by

network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-javascript/"

target="_blank" rel="noreferrer">Learn how to reduce unused JavaScript.

70. Lighthouse seo (desktop): 92/100

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lighthouse.seo-desktop

Detail

Score 92 is below target 95. See HTML report for details.

71. LH desktop: Eliminate render-blocking resources (Est savings of

320 ms)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.render-blocking-resources-desktop

Detail

Resources are blocking the first paint of your page. Consider delivering critical JS/CSS inline and deferring all

non-critical JS/styles. https://developer.chrome.com/docs/lighthouse/performance/render-blocking-resources/"

target="_blank" rel="noreferrer">Learn how to eliminate render-blocking resources.

72. LH desktop: Minify JavaScript (Est savings of 5 KiB)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.unminified-javascript-desktop

Detail

Minifying JavaScript files can reduce payload sizes and script parse time.

https://developer.chrome.com/docs/lighthouse/performance/unminified-javascript/" target="_blank"

rel="noreferrer">Learn how to minify JavaScript.

73. LH desktop: Reduce unused CSS (Est savings of 32 KiB)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.unused-css-rules-desktop

https://waxxbrandz.com/
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Detail

Reduce unused rules from stylesheets and defer CSS not used for above-the-fold content to decrease bytes

consumed by network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-css-rules/"

target="_blank" rel="noreferrer">Learn how to reduce unused CSS.

74. LH desktop: Reduce unused JavaScript (Est savings of 185 KiB)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.unused-javascript-desktop

Detail

Reduce unused JavaScript and defer loading scripts until they are required to decrease bytes consumed by

network activity. https://developer.chrome.com/docs/lighthouse/performance/unused-javascript/"

target="_blank" rel="noreferrer">Learn how to reduce unused JavaScript.

75. LH desktop: Serve images in next-gen formats (Est savings of

6,333 KiB)

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier8.lh-opportunity.modern-image-formats-desktop

Detail

Image formats like WebP and AVIF often provide better compression than PNG or JPEG, which means faster

downloads and less data consumption. https://developer.chrome.com/docs/lighthouse/performance/uses-webp-

images/" target="_blank" rel="noreferrer">Learn more about modern image formats.

76. Dutchie menu iframe not found on /, /menu, or /shop

Severity: P3

Page URL: https://waxxbrandz.com/

Rule: tier-revenue.dutchie.iframe-absent

Detail

No Dutchie iframe detected. If this client uses a different menu provider, add it to clients.yaml dutchieSlug=null

+ we'll stop flagging.

Findings by Page

Grouped by URL — useful when working through the site one page at a time.

https://waxxbrandz.com/
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_44 findings on this page_

[P1] Age gate not detected 🔴  DO FIRST

Your homepage doesn't display an age verification prompt before visitors can access cannabis product content.

Cannabis retailers are legally required to verify customers are 21+ before allowing access

[P1] 21 broken internal link(s) 🔴  DO FIRST

Your website has 21 broken internal links — URLs that point to pages that no longer exist or are misconfigured.

When visitors click these links, they hit dead-end 404 error pages, which damages trust

[P1] A11y: Frames must have an accessible name 🔴  DO FIRST

Your website has an embedded video player (iframe element) that screen readers cannot identify or describe to

visually impaired visitors. Screen readers are software that reads web content aloud to bl

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your homepage doesn't include JSON-LD structured data—a machine-readable format that tells search engines

(Google, Bing) what your business is, where it's located, and what products you sell. Without

[P2] 26 image(s) missing alt text 🟠  HIGH

Your site has 26 images without alt text—short descriptions that explain what each image shows. Search

engines can't read images, so they rely on these descriptions to understand your content. People

[P2] No H1 on homepage

[P2] Missing core schema types: Organization, LocalBusiness, WebSite

[P2] Missing security header: strict-transport-security

[P2] Missing security header: x-frame-options

[P2] Missing security header: content-security-policy

[P2] 21 tap targets under 44px at mobile-320

[P2] 21 tap targets under 44px at mobile-375

[P2] 21 tap targets under 44px at mobile-414

[P2] 14 tap targets under 44px at tablet-768

[P2] Lighthouse perf (mobile): 62/100

[P2] Lighthouse bestPractices (desktop): 74/100

[P2] A11y: Heading levels should only increase by one (×2)

[P2] A11y: All page content should be contained by landmarks

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] Heavy page weight (mobile): 116085KB

[P3] Heavy page weight (desktop): 114091KB

[P3] Missing security header: x-content-type-options

[P3] Missing security header: referrer-policy

[P3] Missing security header: permissions-policy

[P3] SSL Labs grade: unknown

[P3] DNSSEC not enabled

[P3] No CAA DNS records

[P3] DMARC policy is p=none (monitoring only)



[P3] Lighthouse bestPractices (mobile): 79/100

[P3] Lighthouse seo (mobile): 92/100

[P3] LH mobile: Preconnect to required origins (Est savings of 340 ms)

[P3] LH mobile: Eliminate render-blocking resources (Est savings of 1,190 ms)

[P3] LH mobile: Minify JavaScript (Est savings of 5 KiB)

[P3] LH mobile: Reduce unused CSS (Est savings of 32 KiB)

[P3] LH mobile: Reduce unused JavaScript (Est savings of 185 KiB)

[P3] Lighthouse seo (desktop): 92/100

[P3] LH desktop: Eliminate render-blocking resources (Est savings of 320 ms)

[P3] LH desktop: Minify JavaScript (Est savings of 5 KiB)

[P3] LH desktop: Reduce unused CSS (Est savings of 32 KiB)

[P3] LH desktop: Reduce unused JavaScript (Est savings of 185 KiB)

[P3] LH desktop: Serve images in next-gen formats (Est savings of 6,333 KiB)

[P3] Dutchie menu iframe not found on /, /menu, or /shop

https://waxxbrandz.com/waxx-authentic-product/

_7 findings on this page_

[P2] Missing meta description

[P2] Missing canonical 🟠  HIGH

Your product page doesn't tell search engines which version of the URL is the 'official' one. Without this signal,

Google may index duplicate or near-duplicate versions of the same page (like with or

[P2] No JSON-LD schema 🟡  MEDIUM

Your product pages don't include JSON-LD structured data — machine-readable code that tells search engines

what your products are, their prices, and availability. Without it, Google can't easily under

[P3] Title length 4 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

[P3] 1 image(s) missing alt text

https://waxxbrandz.com/industry/trends/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your /industry/trends/ page is missing a meta description — the 160-character summary that appears below

your page title in Google search results. Without it, Google generates a random snippet from yo

[P2] No JSON-LD schema 🟡  MEDIUM

Your product pages and blog posts don't have JSON-LD schema markup—this is invisible code that tells Google

what your content is about (e.g., a product, article, or business). Without it, search engin

[P2] 20 image(s) missing alt text 🟠  HIGH

https://waxxbrandz.com/waxx-authentic-product/
https://waxxbrandz.com/industry/trends/


Every image on your Trends page lacks alt text — the hidden text description that screen readers (used by blind

and low-vision visitors) read aloud, and that search engines use to understand what an i

[P3] Title length 120 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/industry/legalization-updates/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

The page about legalization updates is missing a meta description—the 150-160 character summary that

appears under your page title in Google search results. Without it, Google generates a random snipp

[P2] No JSON-LD schema 🟠  HIGH

Your website isn't using JSON-LD structured data—a machine-readable format that tells Google what your

pages are about. This is like having a product on a shelf with no label; search engines have to g

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your Legalization Updates page is missing alt text — a short text description that describes what

the image shows. Screen readers (used by visually impaired visitors) can't tell users w

[P3] Title length 122 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/industry/market-growth/

_6 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your page about market growth has no meta description — the 160-character preview that appears below your

page title in Google search results. Search engines will auto-generate one from your page cont

[P2] No JSON-LD schema 🟡  MEDIUM

Your website is missing JSON-LD structured data—a machine-readable format that tells Google what your

pages contain (e.g., product details, business hours, reviews). Without it, search engines have to

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your Market Growth page is missing alt text — a short text description that screen readers use

to describe images to visually impaired visitors, and that search engines use to understan

[P3] Title length 119 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/industry/innovation/

_6 findings on this page_

https://waxxbrandz.com/industry/legalization-updates/
https://waxxbrandz.com/industry/market-growth/
https://waxxbrandz.com/industry/innovation/


[P2] Missing meta description 🟠  HIGH

Your product page at /industry/innovation/ is missing a meta description — the 155-character summary that

appears below your page title in Google search results. Without it, Google may auto-generate a

[P2] No JSON-LD schema 🟠  HIGH

Your product pages don't include JSON-LD structured data — a machine-readable format that tells search

engines (and voice assistants) what your pages are about. Without it, Google has to guess whether

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your Innovation page is missing alt text — descriptive text that screen readers use to tell visually

impaired visitors what an image shows, and that search engines use to understand you

[P3] Title length 133 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/

_6 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟡  MEDIUM

Your product and guide pages don't include JSON-LD structured data—machine-readable code that tells

Google what your content is about. Without it, search engines can't easily understand that you're a

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your Live Resin vs Live Diamonds page is missing alt text — a short text description that screen

readers use to explain images to blind and low-vision visitors, and that search engines

[P3] Title length 91 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-

california/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

This page is missing a meta description — the 155-character summary that appears below your page title in

Google search results. Without it, Google generates a random snippet from your content, which

[P2] No JSON-LD schema 🟠  HIGH

Your site is missing JSON-LD structured data — machine-readable code blocks that tell Google what your

content is about. Without them, search engines can't easily understand whether a page is a blog p

[P2] 20 image(s) missing alt text

[P3] Title length 85 chars

[P3] Missing OpenGraph metadata

https://waxxbrandz.com/guides/live-resin-vs-live-diamonds-vapes/
https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/
https://waxxbrandz.com/guides/verify-authentic-disposable-vapes-california/


[P3] Missing Twitter card

https://waxxbrandz.com/disposable-vapes/california/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your product page (disposable vapes in California) is missing a meta description—the 160-character summary

that appears under your site name in Google search results. Without it, Google generates its

[P2] No JSON-LD schema 🟠  HIGH

Your product pages don't include structured data—machine-readable code that tells search engines what your

products are, their price, availability, and reviews. Without it, Google has to guess what yo

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your Disposable Vapes page is missing alt text — a short text description that screen readers

use to describe images to blind and low-vision visitors, and that search engines use to und

[P3] Title length 85 chars

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/blog-page/

_6 findings on this page_

[P2] Missing meta description

[P2] Missing canonical 🟠  HIGH

Your blog page doesn't have a canonical tag — a line of code that tells search engines which version of a page

is the 'official' one. Without it, search engines may get confused if the same content ap

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog page doesn't include JSON-LD structured data — invisible code that tells search engines what your

content is about. Without it, Google can't reliably understand whether a page is a product l

[P2] 27 image(s) missing alt text 🟠  HIGH

Every image on your blog page is missing alt text — a short text description that tells both screen readers and

search engines what the image shows. This hurts visitors who use screen readers (accessi

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/category/industry/

_6 findings on this page_

[P2] Missing meta description

[P2] Missing canonical 🟡  MEDIUM

Your category page doesn't have a canonical tag — a HTML instruction that tells search engines which version

of a page is the 'official' one. Without it, Google may not know if this page, a duplicate,

https://waxxbrandz.com/disposable-vapes/california/
https://waxxbrandz.com/blog-page/
https://waxxbrandz.com/category/industry/


[P2] No JSON-LD schema

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your category pages lacks alternative text—a text description that screen readers use to

describe images to visually impaired visitors, and that search engines use to understand image c

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/category/guides/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your guides category page is missing a meta description — the short summary that appears under your page

title in Google search results. Without it, Google generates a random excerpt from your page co

[P2] Missing canonical 🟠  HIGH

Your category page (/category/guides/) doesn't tell search engines which version is the 'official' one. If this

page is accessible via multiple URLs (like with or without trailing slashes, or via diff

[P2] No JSON-LD schema 🟡  MEDIUM

Your site isn't providing structured data (JSON-LD) — machine-readable information that search engines use to

understand your content. Without it, Google can't easily identify what your guides are abo

[P2] 20 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/category/disposable-vapes/

_6 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your category page for disposable vapes doesn't have a meta description — that's the 155-character summary

that appears below your page title in Google search results. Without it, Google will auto-gen

[P2] Missing canonical 🟠  HIGH

This page lacks a canonical tag — a line of code that tells Google which version of a page is the 'official' one.

Without it, search engines may not know if this category page is the primary version o

[P2] No JSON-LD schema 🟠  HIGH

Your product pages are missing structured data — machine-readable code that tells Google exactly what

products you sell, their prices, and availability. Without it, search engines have to guess what y

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your Disposable Vapes category page is missing alt text—a short text description that describes

what the image shows. Screen readers (tools blind and low-vision visitors use to browse t

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/category/guides/
https://waxxbrandz.com/category/disposable-vapes/


https://waxxbrandz.com/author/692555pwpadmin/

_6 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your author archive page is missing a meta description — the 160-character summary that appears below your

page title in Google search results. Without it, Google generates a generic snippet from your

[P2] Missing canonical 🟡  MEDIUM

Your site has a page (/author/692555pwpadmin/) without a canonical tag — a single line of code that tells

search engines which version of a page is the 'official' one. Without it, search engines may i

[P2] No JSON-LD schema 🟡  MEDIUM

Your site isn't using JSON-LD structured data, which is a machine-readable format that tells search engines

what your pages are about. Without it, Google and other search engines have to guess the mea

[P2] 20 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/author/budauthority/

_6 findings on this page_

[P2] Missing meta description

[P2] Missing canonical

[P2] No JSON-LD schema

[P2] 20 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/find-us/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your 'Find Us' page is missing a meta description — the 50–160 character summary that appears below your

page title in Google search results. Without it, Google generates a random snippet from your pa

[P2] No JSON-LD schema 🟠  HIGH

Your product pages, location pages, and other key content are missing JSON-LD schema markup — invisible

code that tells Google what your pages are about. Without it, search engines have to guess wheth

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your 'Find Us' page is missing alt text — a text description that screen readers use to tell blind

and low-vision customers what they're seeing. Search engines also use alt text to unde

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/author/692555pwpadmin/
https://waxxbrandz.com/author/budauthority/
https://waxxbrandz.com/find-us/


https://waxxbrandz.com/live-diamonds/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema 🟠  HIGH

Your product pages don't include JSON-LD structured data—a standardized format that tells Google what your

content is about. Without it, search engines have to guess whether a page is about a product,

[P2] 74 image(s) missing alt text

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/live-resin/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

Your live-resin product page doesn't have a meta description — the 155-character summary that appears below

your page title in Google search results. Without it, Google generates a random excerpt from

[P2] No JSON-LD schema 🟠  HIGH

Your product pages (like the live resin page) don't include JSON-LD structured data — machine-readable code

that tells Google what your products are, their prices, and availability. Without it, search

[P2] 74 image(s) missing alt text 🟠  HIGH

Your site has 74 images without alt text — descriptive labels that explain what each image shows to people

using screen readers and to search engines. This makes your site harder to use for visitors w

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/pre-rolls/

_5 findings on this page_

[P2] Missing meta description

[P2] No JSON-LD schema

[P2] 39 image(s) missing alt text 🟠  HIGH

Every image on your Pre-Rolls page is missing alt text — a short text description that explains what the image

shows. Search engines and screen readers (used by people with vision impairments) rely on

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/product/

_5 findings on this page_

[P2] Missing meta description 🟠  HIGH

https://waxxbrandz.com/live-diamonds/
https://waxxbrandz.com/live-resin/
https://waxxbrandz.com/pre-rolls/
https://waxxbrandz.com/product/


Your product pages are missing meta descriptions — the 155-character summary that appears under your site

link in Google search results. Without these, Google generates a generic snippet from your pag

[P2] No JSON-LD schema 🟡  MEDIUM

Your product pages don't include structured data—machine-readable code that tells search engines (Google,

Bing) what your products are, their prices, ratings, and availability. Without it, search engi

[P2] 43 image(s) missing alt text 🟠  HIGH

Every product image on your site is missing alt text — a text description that screen readers announce to

visually impaired visitors and that search engines use to understand what's in the image. With

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/verify/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

The /verify/ page is missing a meta description — the short text snippet (150–160 characters) that search

engines display under your page title in results. Without it, Google may auto-generate a snipp

[P2] No JSON-LD schema 🟡  MEDIUM

Your website doesn't include JSON-LD structured data, which is machine-readable code that tells search

engines what your pages contain. For a cannabis retail site, this means Google can't automaticall

[P2] 5 image(s) missing alt text 🟠  HIGH

Five images on your age-verification page have no alt text—a description that screen readers use to understand

images, and that search engines use to index visual content. This means customers using a

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/our-blog/

_5 findings on this page_

[P2] Missing meta description 🟡  MEDIUM

Your blog index page (/our-blog/) is missing a meta description — the 155-character text snippet that appears

below your page title in Google search results. This means Google will auto-generate a des

[P2] No JSON-LD schema 🟡  MEDIUM

Your blog page doesn't include JSON-LD structured data — a standardized format that tells search engines

what your content is about. Without it, Google has to guess whether a page is a product listing

[P2] 20 image(s) missing alt text 🟠  HIGH

Every image on your blog page lacks alternative text (alt text) — a short text description that appears if an

image doesn't load and is read aloud by screen readers used by people with vision disabili

[P3] Missing OpenGraph metadata

[P3] Missing Twitter card

https://waxxbrandz.com/verify/
https://waxxbrandz.com/our-blog/


https://waxxbrandz.com/california-vape-guide/

_1 finding on this page_

[P1] Page returns 404: https://waxxbrandz.com/california-vape-guide/ 🔴  DO FIRST

A page listed in your sitemap (the file search engines use to find content) is returning a 404 error, meaning it no

longer exists or is broken. Search engines and customers who click links to this pag

https://waxxbrandz.com/diamonds-vs-live-resin-distillate/

_1 finding on this page_

[P1] Page returns 404: https://waxxbrandz.com/diamonds-vs-live-resin-distillate/ 🔴  DO FIRST

Your sitemap lists a product comparison page (diamonds vs. live resin distillate) that no longer exists on your

site. When customers click links to this page from search results or your sitemap, they

https://waxxbrandz.com/fix-disposable-vape-clog/

_1 finding on this page_

[P1] Page returns 404: https://waxxbrandz.com/fix-disposable-vape-clog/ 🔴  DO FIRST

One of your pages listed in your sitemap (the file search engines use to discover content) is returning a 404

error — meaning it no longer exists or is misconfigured. When customers click links to thi

https://waxxbrandz.com/wp-login.php

_1 finding on this page_

[P0] Sensitive artifact exposed: /wp-login.php 🔴  DO FIRST

Your WordPress admin login page is publicly accessible at waxxbrandz.com/wp-login.php. This is a security risk

because it gives attackers a known entry point to attempt break-ins. While WordPress site
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